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IDENTIFICACIÓN DE VARIABLES AMBIENTALES QUE INFLUYEN EN LA 
FORMACIÓN DE CÁRCAVAS EN LA MIXTECA OAXAQUEÑA 

María Lorenza Toledo Medrano, M.C. 
Colegio de Postgraduados, 2017 

 

RESUMEN 

La presente investigación busca identificar las variables ambientales que favorecen la 

formación de cárcavas en la Mixteca Oaxaqueña, a través de un análisis multivariado de 

los principales factores, que reporta la literatura, que influyen en este tipo de erosión. El 

presente trabajo inicia con la identificación de las diversas variables que reporta la 

literatura en la formación de cárcavas y continúa con la recopilación de cartografía en 

escala superior a 1:50 000. Las variables preseleccionadas fueron sometidas a un 

análisis estadístico para discriminar aquellas tenían altas correlaciones entre sí, de este 

proceso resultaron: distancia a fallas, distancia a picos, pendiente, curvatura vertical, 

curvatura horizontal, índice de posición topográfica, longitud de la pendiente, índice 

topográfico de humedad, densidad de población e índice de vegetación de diferencias 

normalizadas (NDVI). Sobre estas variables se aplicó el análisis de componentes 

principales (ACP) resultando que los primeros seis componentes condensan el 96.7% de 

la información contenida en las 10 capas analizadas. Con estos seis componentes se 

realizó la clasificación supervisada y se obtuvieron las zonas con presencia y 

susceptibilidad a la formación de cárcavas. Para validar las áreas clasificadas con 

problemas de cárcavas se verificó las áreas con una probabilidad superior al 50% en 

google earth. La confiabilidad del mapa resultante, en función de ausencia y presencia 

de cárcavas fue de 96.2%; para un buffer de 50 m resultó del 83.4%, para uno de 100 m 

fue 81.7% y para uno de 150 m alcanzó el 77.9%. Del trabajo se concluye que las 

variables de mayor influencia, en la formación de cárcavas son: distancia a fallas, 

distancias a picos, índice topográfico de humedad, NDVI, pendiente del terreno y 

densidad de población. 

Palabras Clave: Máxima verosimilitud, análisis multivariado, puntos de muestreo, 

modelos de elevación. 
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IDENTIFICATION OF ENVIRONMENTAL VARIABLES THAT INFLUENCE THE 
FORMATION OF GULLIES IN THE MIXTEC OF OAXACA 

María Lorenza Toledo Medrano, M.C. 

Colegio de Postgraduados, 2017 

ABSTRACT 

The present research seeks to identify the environmental variables that favor the 

formation of gullies in the Mixtec of Oaxaca, through a multivariate analysis of the main 

factors reported in the literature, which influence this type of erosion. . The present work 

begins with the identification of the various variables reported in the literature on the 

formation of gullies and it continues with the compilation of cartography on a scale greater 

than 1:50 000. The pre-selected variables were subjected to a statistical analysis to 

discriminate those that had high correlations with each other; of this process was 

obtained: distance to faults, distance to peaks, slope, vertical curvature, horizontal 

curvature, Topographic Position Index, slope length, Topographic Index of humidity, 

population density and Normalized Difference Vegetation Index (NDVI). On these 

variables, the principal component analysis (PCA) was applied, resulting that the first six 

components condense 96.7% of the information contained in the 10 layers analyzed. With 

these six components, the supervised classification was made and the areas having or 

showing susceptibility to gully formation were obtained. In order to validate the areas 

classified as gully areas, areas with a probability greater than 50% in google earth were 

verified. The reliability of the resulting map, based on absence and presence of gullies 

was 96.2%; for a buffer of 50 m it was 83.4%, for one of 100 m it was 81.7% and for one 

of 150 m it reached 77.9%.  From this work, it was concluded that the variables of greater 

influence in the formation of gullies in the study area, in order of importance, are: distance 

to faults, distances to peaks, topographic index of humidity, NDVI, land slope and 

population density. 

 

 

 

Keywords: Maximum likelihood, multivariate analysis, sampling points, elevation 
models. 
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1. INTRODUCCIÓN 

La erosión se considera un problema de degradación del suelo con impactos 

ambientales, económicos y sociales permanentes. La pérdida de suelo, con el paso del 

tiempo, reduce la profundidad de la capa superficial del suelo, baja la fertilidad, disminuye 

el rendimiento de los cultivos e incrementa la marginación y pobreza de las poblaciones. 

Una forma avanzada de la erosión son las cárcavas, que afecta a gran parte de los suelos 

del mundo, es fuente de sedimentos que azolvan cauces y colmatan embalses, reducen 

la calidad del agua y alteran las propiedades hidráulicas en cauces e infraestructura 

(Pathak et al., 2005). 

Las cárcavas son resultado de las actividades antrópicas, como el sobrepastoreo de 

agostaderos, la agricultura sin control de escurrimientos, la expansión de la frontera 

agrícola en laderas y la deforestación (Pathak et al., 2005).Guerrero-Arenas et al. (2010) 

mencionan que los ecosistemas de la Mixteca alta de Oaxaca, sufrieron una serie de 

transformaciones desde el Pleistoceno tardío hasta el Holoceno, las comunidades 

originales eran bosques abiertos con cuerpos de agua y estacionalidad climática, y 

terrenos con abundante materia orgánica; recientemente, después de la conquista, el 

área estuvo sometida a procesos de deforestación, sobrepastoreo de ganado caprino 

(Mendoza-García, 2002) y expansión de la frontera agrícola. Todo ello provocó, el 

desastre ecológico que en amplias superficies de la Mixteca la erosión en cárcavas sea 

un problema latente y difícil de controlar. 

El control de este tipo de erosión requiere conocer las variables que favorecen la 

formación de cárcavas, con el fin de prevenir el incremento del área afectada. Para 

caracterizar las variables que influyen en la formación de cárcavas se han utilizado 

parámetros morfométricos, geológicos, edafológicos y de cobertura vegetal (Van Ghelue 

y Van Molle, 1990; Hernández, 1991). 

En esta investigación se identificaron las áreas con mayor susceptibilidad de formación 

de cárcavas, a partir de variables ambientales y análisis multivariado. 
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2. OBJETIVOS 

2.1. General 

Identificar áreas susceptibles a la formación de cárcavas, a través de variables 

ambientales. 

2.2. Objetivos particulares 

 Identificar las variables ambientales que influyen, en la formación de cárcavas. 

 Validar estadísticamente el mapa generado con áreas observadas con la 

presencia de cárcavas. 

 

3. HIPOTESIS 

Las variables ambientales permiten identificar los factores que influyen en la formación 

de cárcavas. 
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4. REVISION DE LITERATURA 

Las cárcavas son incisiones que se forman en el terreno cuando se concentra el 

escurrimiento, (Poesen, 1993; Poesen et al., 2003), generalmente se desarrollan en 

capas de materiales no consolidados. Su formación inicia con canalillos pequeños, a 

medida que aumenta el escurrimiento superficial, estos tienden a crecer en profundidad 

y amplitud; hasta formar secciones transversales difíciles de controlar con el laboreo o el 

paso de la maquinaria. 

Al crecer la cárcava, en sentido contrario del agua, recibe el nombre de cárcava 

remontante. El desarrollo comienza con una incisión y termina con un derrumbe que 

desplaza a la cabecera (Gómez et al, 2011). Al comparar dos sitios de cárcavas en 

ubicaciones geográficas diferentes, Casali et al. (2000) concluyen que los procesos 

erosivos son similares: comienzan por una incisión, continua con el ensanchamiento de 

la sección y empinamiento del banco (Figura 1). 

 
Figura 1. Etapas en la evolución de una cárcava. 

 

Las cárcavas se diferencian en efímeras y permanentes; las primeras son aquellas que 

se eliminan mediante el laboreo agrícola. Las cárcavas permanentes son difíciles de 

eliminar con laboreo. Las cárcavas efímeras representan un problema en muchas 

regiones geográficas. 
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4.1. Variables que influyen en la formación de cárcavas 

Los variables que influyen en la formación de las cárcavas se dividen en dos tipos: 

antrópicas y físicas; en las antrópicas es importante el sobrepastoreo;  el manejo de las 

actividades agrícolas, en especial en pendientes pronunciadas, el manejo de los terrenos 

cultivados y la deforestación (Pathak et al., 2005). 

Poesen et al. (2003), menciona que la erosión en cárcavas es función de las propiedades 

del suelo (físico-químicas), su distribución en el espacio (Bull et al., 1997), el uso y 

manejo del terreno, el clima y la topografía. Bocco (1991), menciona que en el desarrollo 

de las cárcavas influyen la topografía, tamaño y forma de la cuenca, intensidad y cantidad 

de lluvia, y el grado y longitud de la pendiente. Para Poesen et al. (2003) y Valcárcel et 

al. (2003), su ocurrencia y evolución está condicionada por la geología, clima, suelo, 

hidrología, uso de suelo, vegetación y manejo. 

 Variable antrópicas 

El tipo de vegetación, estacionalidad, densidad, edad y estado físico son variables que 

controlan o disparan la erosión en cárcavas. Las modificaciones de la red de drenaje, el 

cambio de uso de suelo y de la cubierta vegetal para incremento de frontera agrícola, 

ligadas a eventos extremos de lluvia, son señaladas como las causantes de formación 

de cárcavas (Nyssen et al., 2002). 

 

En áreas con pastoreo, la capacidad de carga es básica para el inicio o progreso de los 

procesos erosivos (Nyssen et al., 2004). El sobrepastoreo, deteriora los ecosistemas, 

reduce la vegetación y deja terrenos expuestos a la acción erosiva. El pisoteo del ganado, 

compacta el suelo, lo que reduce el agua infiltrada (Pathak et al., 2005). 

 

Por otra parte, cuando se construyen vialidades y no se consideran los sistemas de 

desagüe, el exceso de escorrentía produce problemas de cárcavas en los terrenos 

aledaños. 
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 Variables físicas 

Precipitación 

Lal (1992), menciona que la alta intensidad de la lluvia y baja cobertura del suelo son 

condiciones idóneas para generar grandes volúmenes de escorrentía, producir flujo 

concentrado y formar cárcavas.  

Los factores climáticos se relacionan con los agentes erosivos (precipitación y viento). 

Poesen y Hooke (1997) señalan que la intensidad y magnitud de los eventos se asocian 

a la erosión y surgimiento de cárcavas. 

Geomorfología 

Según Meijerink (1988) y Verstappen y Van Zuidam (1991) la geomorfología se relaciona 

con los procesos de erosión, transporte y deposición del suelo; lo cual ayuda a 

caracterizar el relieve y predecir como las deformaciones del terreno impactan la erosión. 

Varios autores han usado elementos morfométricos como forma, aspecto y longitud de 

la pendiente para explicar la génesis de suelos e identificar áreas con riesgo de erosión 

(Meijerink, 1988; Kreznor et al., 1989; Zinck y Valenzuela, 1990; Nizeyimana y Bicki, 

1992; Stolt et al., 1993 y van Ghelue et al., 1990). Según Pathak et al. (2005) el tamaño 

y forma de un área de drenaje, la longitud y grado de la pendiente son variables que 

influyen en la velocidad de la escorrentía y la erosión. Patton et al. (1975) mencionan 

que el desarrollo de una cárcava es un umbral topográfico, a mayor pendiente más 

velocidad del agua y mayor la posibilidad de formar cárcavas.  

De acuerdo con lo antes mencionado las variables que influyen en la formación de 

cárcavas, son: 

 Material parental: determina la génesis del suelo, profundidad, fases físicas y 

propensión a la erosión. 

 Pendiente del terreno: representa el cambio de altitud entre dos puntos en relación 

con la distancia que los separa, se expresa en grados o porcentaje 

 Longitud de la pendiente: corresponde a la proyección horizontal en una ladera, 

entre mayor sea su magnitud mayor la erosión. 
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 Orientación o aspecto del terreno: se refiere a la dirección horizontal con respecto 

al sol. Esta variable es determinante en el clima y la cobertura vegetal. 

 Curvatura del terreno: representa la tasa de cambio de la pendiente en el espacio 

e indica la concavidad o convexidad de un terreno. La curvatura plana u horizontal 

es perpendicular a la máxima pendiente y depende de la pendiente y del aspecto. 

 Índice topográfico de humedad: define los sitios donde hay acumulación de agua 

se relaciona con la generación de escorrentía. 

 Índice topográfico de humedad: define los sitios donde hay una tendencia 

topográfica a acumular agua y es función directa del área de aporte. Esta se 

relaciona con la humedad del suelo y refleja la tendencia de este a generar 

escorrentía. 

 Índice de posición topográfica o índice topográfico compuesto: clasifica con base 

en variables morfológicas las geoformas de un lugar según su posición relativa en 

el paisaje (Moore et al., 1991). 

Suelos 

Las propiedades físicas del suelo juegan un papel importante en crear y desarrollar 

cárcavas. Entre las variables más usadas, para determinar la fragilidad de un suelo a 

erosionarse, están la erodabilidad y la resistencia al esfuerzo cortante. Ambas están 

determinadas por la textura del suelo y la permeabilidad (Poesen et al., 1999). Los 

vertisoles son suelos susceptibles de formar cárcavas por su propiedad de formar grietas 

(Pathak et al., 2005). 

La cubierta vegetal 

Un terreno con cubierta vegetal favorece la infiltración y aumenta la resistencia al 

escurrimiento. Por otro lado, en suelos con escasa cubierta vegetal su superficie está 

expuesta a la acción erosiva de la lluvia y al arrastre de partículas, cuando se presenta 

la concentración de escurrimientos, lo que favorece la formación de cárcavas (Pathak et 

al., 2005. Para cuantificar la densidad de la cobertura vegetal se usan sensores remotos 

e índices de vegetación. Estos índices se basan en los valores de reflectancia en las 

zonas espectrales del rojo (RED) e infrarrojo cercano (NIR). Entre los más usados están 
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el índice de vegetación ajustado al suelo (SAVI) y el índice de vegetación de diferencias 

normalizadas (NDVI). 

 

4.2. Procesos de aparición de cárcavas 

El flujo concentrado es un factor importante en la formación de cárcavas (Knapen et al., 

2007), aparecen cuando el esfuerzo cortante del flujo supera la resistencia de las 

partículas de suelo (Gómez et al., 2011). La fuerza que se ejerce sobre la superficie del 

suelo se representa por el esfuerzo cortante del flujo (Lyle y Smerdon, 1965) y por 

potencial de la corriente (Bagnold, 1977; Knapen et al., 2007). 

Las cárcavas pueden ser resultado del flujo del agua en túneles, los cuales son 

estructuras tubulares que al desgastarse se colapsan y se genera un escalón que, tras 

la acción del flujo superficial, se convierte en la cabecera de estas (Jones, 1981). 

La pérdida de suelo representan  una dinámica de cambio en cortos tiempos creándose 

la necesidad de probar metodologías rápidas, precisas y de bajos costos para la 

evaluación de esta, los sensores remotos y sistemas de información geografía (SIG) son 

herramientas que contribuyen a cumplir estos requisitos (Buendía-Rodríguez et al., 

2008). 

 

4.3. Uso de los sensores remotos y SIG 

Los sensores remotos son una herramienta de bajo costo para colectar datos de uso, 

cobertura, densidad de drenaje y para evaluar el proceso erosivo y sus consecuencias 

en las zonas afectadas (Chuvieco, 2002; Bagyaraj et al., 2013). Por otra parte, los 

sistemas de información geográfica (SIG) son una herramienta que facilita el análisis de 

información ambiental (Martín et al., 1998). 
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4.4. Enfoques para el estudio de las cárcavas 

La clasificación de la erosión en cárcavas se orienta a identificar la morfología y el grado 

de desarrollo (Ireland et al., 1939; Heede, 1970; Imeson y Kwaad, 1980; Crouch y Blong, 

1989). Gómez et al. (2011) mencionan que las cárcavas se analizan con base en la 

morfología de la cabecera de la sección, génesis y morfología, lugar topográfico y 

estructura de la red de drenaje. Al clasificar cárcavas, el principal objetivo es el avance 

de las cabeceras (Meyer et al., 1999). 

Para analizar la influencia en la génesis de cárcavas, en India, Bagyaraj et al. (2011) 

utilizaron variables morfométricas para caracterizar los accidentes geográficos 

(topoformas) y parámetros del suelo, como textura, drenaje y erosión. Bagyaraj et al. 

(2013) identificaron zonas de riesgo de erosión potencial con variables de densidad de 

drenaje y unidades geomorfológicas.  

Con base en las relaciones suelo-paisaje y los procesos de erosión por cárcavas y 

barrancos, González (1998) analizó la importancia de los análisis morfológicos, a escala 

semidetallada, para el estudio hidrográfico, identificación de áreas afectadas e inventario 

de suelos en cuencas fluviales. En un estudio cuantitativo de la red de drenaje realizado 

por Sanjulián y Urdiain (1983) utilizaron análisis morfométricos para jerarquizar la red 

fluvial. Okereke et al. (2012) identificaron, por medio de sensores remotos y técnicas SIG, 

los patrones de drenaje y la manera en que interactúan con el desarrollo de la erosión 

en cárcavas en el suroeste de Nigeria. Con imágenes de satélite y sensores remotos 

Khan (2003) cuantificó las tasas de erosión en banco a lo largo del río Brahmaputra–

Jamuna, Bangladesh, India. 

Por su parte Abdullah et al. (2013), encontraron que la banda 5 de la imagen Landsat 

ETM-7 es apropiada para identificar los patrones de drenaje, encuentran que las técnicas 

de teledetección y SIG son herramientas poderosas para identificar estructuras 

geológicas, aunado a la capacidad para realizar superposiciones para determinar 

relaciones espaciales de diferentes factores que intervienen en áreas con fallas 

geológicas. Abdullah (2013) realizó un estudio en Yemen en el que utiliza sensores 
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remotos para detectar las características estructurales, como fallas; el aporte es útil, ya 

que permite identificar las áreas afectadas por erosión en cárcavas. 

Camargo et al. (2014), en la microcuenca La Machirí, para los periodos 1952, 1976 y 

2010, con apoyo de los SIG y software fotogramétrico digital (SFD) evaluaron la dinámica 

de los volúmenes de suelo desplazados. Concluyen que resulta inevitable usar el 

delineado manual para interpretar las imágenes de satélite. Dada complejidad para 

elaborar una cartografía de cárcavas, Mararakanye y Le Roux (2012) produjeron, a 

través de imágenes SPOT 5, un mapa de barrancos y cárcavas mediante interpretación 

visual y vectorización. 

Con análisis de imágenes orientado a objetos, Wang et al. (2014), desarrollaron una 

metodología para cuantificar el volumen de erosión en cárcavas en China. Shruthi et al. 

(2011) plantearon algo similar al utilizar imágenes de alta resolución espectral, 

combinadas con la topografía y el rango espectral de las imágenes. Asimismo, usando 

imágenes Lidar, Höfle et al. (2013) realizó en Perú un estudio para delinear 

automáticamente cárcavas y describir su geomorfometría. 

 

4.5. Técnicas de análisis para la identificación de cárcavas 

 Análisis multicriterio 

El análisis multicriterio (o combinación lineal ponderada) en SIG, través de capas 

temáticas, permite conocer la influencia de las variables sobre un tema geográfico de 

interés. Este análisis determina la interdependencia a partir de una mezcla lineal de 

probabilidades ponderadas para cada cobertura temática según su aptitud, lo que 

permite la toma de decisiones rápida (Bagyaraj et al., 2013). Los análisis multicritero son 

útiles para seleccionar las variables con mayor influencia en la formación de cárcavas. 

 Análisis multivariado 

El análisis multivariado permite relacionar la estructura y forma del relieve con la 

dinámica espacial-temporal de la erosión, para ello es necesario caracterizar las 

variables morfométricas con el uso de SIG y sensores remotos. 
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En la estadística multivariada, el análisis de componentes principales (ACP) es la técnica 

de mayor uso (Abdi et al., 2010); Inicialmente el ACP se aplicó en la medicina, con el 

paso del tiempo se introdujo en las ciencias sociales y en las últimas décadas en las 

ciencias ambientales. En esta última, se usa para identificar variables que influyen en los 

procesos ambientales y pueden generar riesgos a la humanidad. 

En el ACP las variables son representadas de manera vectorial a fin de convertir un grupo 

de variables, correlacionadas entre sí, en variables sintéticas sin correlación. El propósito 

de los análisis de componentes principales es reducir al máximo el número de variables 

del fenómeno a representar (Jolliffe, 2002). En el nuevo sistema de variables no hay 

información repetida y las variables no están correlacionadas entre sí, es decir, los 

nuevos componentes son linealmente ortogonales (independientes), las varianzas y 

covarianzas se comportan diagonalmente y las varianzas decrecen progresivamente 

(Ferrero et al., 2002). 

La mayor varianza, corresponde al primer componente principal. . Del conjunto de 

variables, seguido del cálculo de valores propios, se elabora la matriz de covarianzas. El 

error en ACP no siempre es cero y puede presentarse el caso, dependiendo de la 

aplicación, que las varianzas bajas tengan alta relevancia predictiva (Sewell, 2007). 

En la siguiente Figura 2 se ilustra el concepto para dos variables, con el uso de la 

distribución de los valores. En (a) se observa la distribución en el espacio de X1, X2 y 

sus medias. La dispersión de las varianzas de los puntos, alrededor de la media (µ1 - 

µ2), indica la correlación y calidad de la información. En este caso, se busca que las 

variables no estén correlacionadas, (b) el nuevo conjunto de coordenadas se obtiene 

rotando el eje alrededor de las medias (µ1 - µ2), esto es, se resta a las variables 

originales la media (X1´= X1- µ1 y X2´= X2- µ2). El nuevo eje resultante, asociado a la 

máxima varianza, se le denomina PC1 “Primer Componente Principal”, el segundo 

componente principal debe ser ortogonal al primero. 
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Figura 2. Concepto de Componentes principales para 2CP1 

 

La selección del número de componentes principales se realiza con el gráfico de 

sedimentación, el cual incluye, en el eje de las X, el número de CP y en Y los valores 

propios (eigenvalores) de cada componente. De este modo, la elección de CP se basa 

en observar los cambios de pendiente del gráfico, hasta que la línea de tendencia 

comience a estabilizarse, sin embargo, esto depende de la cantidad de información que 

esté dispuesto el investigador a eliminar. 

 Clasificación supervisada 

La clasificación supervisada es una técnica usada en investigaciones ambientales para 

agrupar información (clústeres) proveniente de diversas fuentes; por ejemplo, de 

estudios de usos de suelo y vegetación, sitios con riesgo a deslizamientos, áreas con 

problemas de erosión, determinación de potencial de recarga de acuíferos, entre otros.  

La clasificación supervisada de variables, consiste en categorizar estadísticamente los 

datos de campo según las clases observadas en el área de estudio. El método parte de 

definir las categorías, observar la distribución de los sitios de muestreo y verificar los 

resultados (Chuvieco, 1990). La aplicación de este método requiere que el clasificador 

tenga conocimiento del área de trabajo para definir los polígonos de entrenamiento y que 

                                                           
1 http://docencia.med.uchile.cl/smg/pdf/PCA%20ingenieros.pdf 
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sus valores estadísticos (media, rango, varianza, desviación estándar, covarianza, etc.) 

sean representativos. 

Con base en la revisión bibliográfica se observa que las variables responsables en la 

formación de cárcavas se dividen, de acuerdo con su origen, en antrópicas, geológicas, 

hidrológicas, topográficas, geomorfológicas y de cobertura vegetal. Teniendo en cuenta 

esta división, la disponibilidad y escalas de la información y la correlación entre las 

diversas variables, en este trabajo se incluyó la densidad de población (antrópica); 

distancia a fallas y a picos (geológicas); Índice topográfico de humedad (hidrológica); 

pendiente, curvatura vertical, curvatura horizontal, longitud de la pendiente 

(topográficas); índice de posición topográfica (geomorfológica); y NDVI (cobertura 

vegetal).Se aplicó el ACP para reducir la información redundante, estimar por el método 

de máxima verosimilitud (en forma supervisada) la probabilidad de presencia de cárcavas 

y validar su existencia a través de fotografías aéreas. 
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5. MATERIALES Y MÉTODOS 

5.1. Caracterización biofísica 

5.1.1. Ubicación geográfica del área de estudio 

El área de estudio, tiene una superficie de 6167.5 km2, se ubica al noroeste del estado 

de Oaxaca y cubre el 39.3% de la Mixteca Oaxaqueña. Esta región es conocida, a nivel 

mundial, por su importancia bilógica y cultural. Políticamente se encuentra en los distritos 

Oaxaqueños de Coixtlahuaca (24.28%), Juxtlahuaca (5.93%), Nochixtlán (20.29%), 

Teposcolula (19.53%) y Tlaxiaco (29.97%), específicamente entre las coordenadas 

geográficas 16° 55’ 32.46” y 18° 7’ 2.74” de latitud norte y 97° 58’ 13.35” y 97° 01’ 7.42” 

de longitud oeste (Figura 3). 

 

 
Figura 3. Ubicación geográfica del área de estudio. 
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5.1.2. Clima 

Factores como latitud, longitud, altitud, relieve, proximidad al mar, corrientes marinas y 

vegetación son condicionantes del clima e influyen en la distribución espacio-temporal 

de las temperaturas y precipitaciones de un determinado lugar. Existen varias 

metodologías para clasificar el clima, sin embargo, en México la más aplicada es la de 

Köppen, modificada por Enriqueta García, basada en temperatura media mensual y 

precipitación mensual de un periodo mínimo de 30 años. 

La cartografía de unidades climáticas de INEGI (2008), con base en la clasificación de 

Köppen modificado por Enriqueta García (2004) y escala 1:1 000 000, reporta que en la 

zona de estudio se presentan tres grupos climáticos, secos, templados y cálidos (Cuadro 

1 y Figura 4). 

 

 
Cuadro 1. Tipos de climas del área de estudio. 

Grupo Clave Área (km2) Área (%) 

Cálido A(C)w0(w) 397.57 6.45 

 A(C)w2(w) 147.08 2.38 

  Aw0(w) 0.23 0 

Seco BS0(h')w(w) 48.45 0.79 

 BS0hw(w) 9.85 0.16 

 BS1h'(h)w(w) 69.7 1.13 

 BS1hw(w) 277.91 4.51 

  BS1kw(w) 645.96 10.47 

Templado C(E)(w2)(w) 34 0.55 

 C(w0)(w) 1,460.05 23.67 

 C(w1)(w) 1,321.1 21.42 

  C(w2)(w) 1,755.56 28.46 

Total general 6,167.46 100 
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Figura 4. Tipos de climas en la Mixteca Oaxaqueña (INEGI, 2008). 
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5.1.2.1.  Grupo climático Cálido 

 

Aw0(w): Cálido el menos húmedo de los subhúmedos con régimen de lluvias en verano, 

cociente de precipitación entre temperatura 2  menor o igual a 43.2 mm °C-1 y un 

porcentaje de lluvia invernal menor a cinco. La temperatura media anual es mayor de 

22°C y la del mes más frio es mayo de 18°C. 

 

Aw1(w): Cálido subhúmedo con lluvias en verano, con un porcentaje de precipitación 

invernal menor a cinco, cociente de precipitación entre temperatura mayor a 43.2 y menor 

a 55.32 mm °C-1. La temperatura media anual es mayor de 22°C y la del mes más frio es 

mayo de 18°C. 

 

5.1.2.2. Grupo climático semicálido del grupo de los cálidos 

 

A(C)w0(w): Semicálido del grupo de los cálidos el menos húmedo de los subhúmedo con 

lluvias en verano. Cociente de precipitación entre temperatura menor que 43.2 mm °C-1, 

y un porcentaje de lluvia invernal menor a cinco. La temperatura media anual esta entre 

18°C y 22°C, la temperatura del mes más frio es superior a 18°C. 

 

A(C)w2(w): Semicálido del grupo de los cálidos el más húmedo de los subhúmedo con 

lluvias en verano. Cociente de precipitación entre temperatura mayor que 55.0 mm °C-1, 

y un porcentaje de lluvia invernal de menor a cinco. La temperatura media anual esta 

entre 18°C y 22°C, la temperatura del mes más frio es superior a 18°C. 

 

                                                           
2 Cociente (P/T) o índice de Lang (1915), es un índice de aridez que está en función de la precipitación anual y la 
temperatura media anual. Es un indicador de la evaporación y grado de humedad de un lugar. Valores de 0-20 
corresponde a desiertos, 20-40 a zonas áridas, 40-60 a estepas y sabanas húmedas, 60-100 a bosques claros 
húmedos, 100-160 a grandes bosques húmedos, y >160 a zonas muy húmedas. 
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5.1.2.3. Grupo climático seco 

 

Del clima seco se presentan cinco subtipos, definidas por la variación de la precipitación 

y temperatura durante el año, BS0(h')w(w), BS0hw(w), BS1h'(h)w(w), BS1hw(w) y 

BS1kw(w).  

 

BS0(h')w(w): Árido cálido con lluvias en verano, porcentaje de lluvia invernal menor de 5, 

cociente de precipitación entre temperatura menor o igual que 22.9 mm °C-1. La 

temperatura anual es mayor de 22°C y la del mes más frio superior a 18°C. 

 

BS0hw(w): Árido semicálido con lluvias en verano, porcentaje de lluvia invernal menor a 

cinco, cociente de precipitación entre temperatura menor o igual que 22.9 mm °C-1. La 

temperatura media anual esta sobre 18°C y la del mes más frio es menor a 18°C. 

BS1h'(h)w(w): Semiárido, semicálido, con régimen de lluvias en verano y un porcentaje 

de lluvia invernal menor a cinco, cociente de precipitación entre temperatura mayor que 

22.9. La temperatura media anual varía entre 18°C y 22°C y la del mes más frio es 

superior a 18°C. 

 

BS1kw(w): Semiárido, templado con verano cálido, lluvias en verano, con porcentaje de 

precipitación invernal menor a cinco, cociente de precipitación entre temperatura mayor 

que 22.9 mm °C-1. La temperatura media anual fluctúa entre 12°C y 18°C, la del mes 

más frio entre -3°C y 18°C, la del mes más cálido menor a 22°C. 

 

5.1.2.4. Grupo climático Templados 

C(w0)(w): Templado el más seco de los subhúmedos, régimen de lluvias en verano, 

cociente de precipitación entre temperatura menor a 43.2 mm °C-1 y un porcentaje de 

lluvia invernal de menor a cinco. La temperatura media anual varía entre 12°C y 18°C. 
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C(w1)(w): Templado subhúmedo, con régimen de lluvias en verano, cociente de 

precipitación entre temperatura entre a 43.2 y 55.0 mm°C-1, y un porcentaje de lluvia 

invernal de menor a cinco. La temperatura media anual varía entre 12°C y 18°C. 

 

C(w2)(w): Templado el más húmedo de los subhúmedos, con régimen de lluvias en 

verano, cociente de precipitación entre temperatura mayor de 55.0 mm°C-1 y un 

porcentaje de lluvia invernal de menor a cinco. La temperatura media anual varía entre 

12°C y 18°C. 

 

5.1.2.5. Grupo climático Templado Semifrío 

 

C(E)(w2)(w): Templado semifrío el más húmedo de subhúmedo con lluvias en verano, un 

porcentaje de precipitación invernal menor a cinco, temperatura media del mes más frio 

entre -3 y 18º C y la media anual entre 5 y 12°C. 

 

5.1.3. Suelos 

El suelo es un recurso natural indispensable para el desarrollo de los seres vivos y su 

formación requiere la interacción de cinco elementos: material parental, topografía, clima, 

tiempo y organismos. Las condiciones de formación proporcionan sus propiedades y la 

base para su agrupación, de acuerdo a un sistema de clasificación específico. 

 

La metodología propuesta por FAO-UNESCO (1970) y modificada por la Comisión de 

Estudios del Territorio Nacional (CETENAL) en 1970, fue la metodología adoptada en la 

serie I del INEGI (2004) para clasificar suelos en México, la serie II adopta el Sistema de 

Clasificación de Suelos WRB2000. El INEGI (2006) para el área de estudio ( Cuadro 2 y 

Figura 5) reporta ocho grupos de suelos,  el leptosoles (38.18 %), luvisoles (25.13%), 

phaeozem (15.60%), regosoles (11.31%), vertisoles (5.44%), cambisoles (3.66%), 

gleysoles (0.42%), fluvisoles (0.11%) y el 0.15% es área urbana. 
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Cuadro 2. Tipos de suelos. 

Clave Descripción Área (km2) Área (%) 

CMca Cambisol calcárico 74.32 1.2 

CMeu Cambisol éutrico 60.2 0.98 

CMhu Cambisol húmico 91.53 1.48 

FLca Fluvisol calcárico 0.32 0.01 

FL Fluvisol  6.3 0.1 

GLstn Gleysol endostógnico 25.74 0.42 

LPca Leptosol calcárico 477.14 7.74 

LPeu Leptosol éutrico 219.48 3.56 

LP Leptosol  1,658.11 26.88 

LVcc Luvisol cálcico 59.39 0.96 

LVcr Luvisol crómico 520.75 8.44 

LVhu Luvisol húmico 144.44 2.34 

LV Luvisol  89.32 1.45 

LVpf Luvisol profóndico 564.26 9.15 

LVro Luvisol ródico 172.14 2.79 

PHca Phaeozem calcárico 194.88 3.16 

PHcr Phaeozem crómico 0.37 0.01 

PHhu Phaeozem húmico 99.99 1.62 

PHlv Phaeozem lúvico 255.9 4.15 

PH Phaeozem  410.68 6.66 

RGar Regosol arénico 131.12 2.13 

RGca Regosol calcárico 392.11 6.36 

RGeu Regosol éutrico 118.67 1.92 

RG Regosol  55.85 0.9 

VRmz Vertisol mázico 213.77 3.47 

VR Vertisol  121.43 1.97 

ZU Zona urbana  9.25 0.15 

Total general 6,167.46 100.00 
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Figura 5. Tipos de suelos en el área de estudio (INEGI, 2006). 
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5.1.3.1. Descripción de los tipos de suelos 

a) Cambisol 

Son suelos jóvenes con poca evolución, en la mayoría de los casos la posición 

topográfica ha impedido su desarrollo, con una capa superficial obscura mayor a 25 cm, 

y el perfil presenta una capa donde se acumula arcilla. Es evidente la trasformación del 

material parental, por la decoloración parduzca y la formación estructural, pueden tener 

pequeñas acumulaciones de arcillas, carbonatos de calcio, manganeso, potasio y sodio. 

Los suelos sobre roca ácida generan un perfil ligeramente ácido (IUSS Grupo de Trabajo 

WRB, 2006). 

Cambisol Cálcico o calcárico: presenta una capa con espesor mayor a 15 cm, con más 

del 15% de carbonatos de calcio secundarios y concentraciones pequeñas (menor a 

15%) y pulverulentas de carbonatos en los primeros 25 cm del perfil. 

Cambisol éutrico: tiene una saturación de bases, calcio, magnesio, potasio y sodio, 

mayor o igual al 50% entre los 20 y 100 cm de la superficie del suelo o entre 20 cm 

partiendo de roca continua o una capa endurecida. 

Cambisol húmico: con una capa superficial oscura, a veces gruesa, de regular a buen 

contenido de materia orgánica pero pobre en nutrientes. 

 

b) Fluvisoles 

El fluvisol es un suelo joven formado con materiales acarreados por el agua. Son suelos 

muy pocos desarrollados, medianamente profundos y estructura débil o suelta. Se 

encuentra en los lechos de los ríos y presenta capas perturbadas de arena con piedra o 

gravas redondeadas por el efecto del acarreo del agua (IUSS, 2007). 

 

Fluvisol calcárico: presenta enriquecimiento por carbonatos secundarios, menor al 

15%, en una parte de los primeros 50 cm de profundidad del perfil. 
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c) Gleysol 

Son suelos que están inundados la mayor parte del año a aproximadamente 50 cm de 

profundidad, constituido por materiales no consolidados, sedimentos fluviales y 

lacustres, se ubican en zonas bajas. 

 

d) Leptosoles 

Tiene profundidades menores a 25 cm, se encuentran en áreas montañosas teniendo 

como limitantes las elevadas pendientes y la facilidad a erosionarse lo que impide su 

formación. 

Leptosol calcárico: Es calcáreo de la superficie hasta los 20 a 50 cm. 

Leptosol éutrico: Son suelos jóvenes que no presentan ninguna característica especial 

en el perfil. 

 

e) Luvisol 

Los luvisol son suelos de zonas templadas o tropicales lluviosas, aunque se encuentran 

en climas más secos, cubiertos con vegetaciones de bosque o selva. Se caracteriza por 

tener un enriquecimiento de arcilla en el subsuelo y por sus colores rojos, amarillentos y 

pardos. Se ubican en zonas planas o suavemente inclinadas, son fértiles y apropiados 

para usos agrícolas; pero en lugares con pendientes fuertes presentan alto riesgo a la 

erosión. La limitante de este suelo es su alto contenido de limo ya que, al labrarse 

mojados, con maquinaria pesada, son susceptibles a destrucción de su estructura. 

(IUSS, 2007). 

 

Luvisol cálcico: suelos con capa de color blanco, rico en carbonatos en forma de polvo 

blanco o caliche. 

Luvisol crómico: Su color en húmedo es rojizo obscuro y pardo (7.5YR). 

Luvisol húmico: La capa superficial es obscura y rica en materia orgánica. 
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Luvisol profóndico: En el horizonte árgico la distribución de arcilla es tal que su 

contenido no disminuye en más del 20 % del máximo, de forma relativa, dentro de los 

primeros 150 cm. 

Luvisol ródico: El horizonte B es de color más fuerte que 5YR en su mayor parte, 

excluye horizontes de transición. 

 

f) Phaeozem 

Son suelos pardos, que se presentan en cualquier tipo de relieve excluyendo a sitios con 

climas tropicales o muy áridos. Tiene una capa superficial obscura, suave, rica en materia 

orgánica y en nutrientes (Ca, Mg, K, Na). La profundidad de estos es variable, los más 

profundos se ubican en lugares planos, los menos profundos en laderas o pendiente 

teniendo como limitante la roca o la segmentación de suelo para la producción agrícola 

(IUSS, 2007).  

 

Phaeozem calcárico: presenta enriquecimiento secundario de carbonatos, menor al 

15%, entre 20 y 50 cm de la superficie. 

Phaeozem crómico: el horizonte B tiene es en su mayor parte de color rojo con un matiz 

7.5YR. 

Phaeozem húmico: Tiene una capa superficial obscura rica en materia orgánica. 

Phaeozem lúvico: con un subsuelo más rico en arcilla que la capa superficial. 

 

g) Regosol 

Los regosol son suelos ubicados en diferentes tipos de climas, vegetación y relieve. Son 

suelos jóvenes, con capas poco diferenciables entre sí y muy someros. Son el resultado 

de depósitos recientes de roca y arenas acarreadas por el agua. Son de colores claros, 

pobres en materia orgánica y con parecido a la roca madre. Su fertilidad es variable y 

condicionada por la profundidad y pedregosidad (IUSS, 2007).  
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Regosol arénico: Con una textura arenosa-franca fina o más gruesa en la totalidad de 

los primeros 50 cm. 

Regosol calcárico: tienen enriquecimiento secundario de carbonatos calcio, menor al 

15 %, en al menos alguna parte de los primeros 50 cm de profundidad. 

Regosol éutrico: rico o muy rico en nutrientes o bases (Ca, Mg, K, Na) en los primeros 

50 cm de profundidad. 

 

h) Vertisol 

Los vertisol se localizan en climas templados y cálidos, con marcada estación seca y 

lluviosa; en vegetaciones de selvas bajas, pastizales y matorrales; y en depresiones, 

áreas llanas u onduladas. Se caracterizan por una estructura masiva con alto contenido 

de arcilla, característica que provoca la expansión en húmedo formando superficies de 

deslizamiento nombradas facetas, en seco tienen a colapsase por la formación de grietas 

anchas y profundas desde la superficie hacia abajo. Los colores van de negro a grises, 

los hay de color café rojizo (IUSS, 2007).  

 

Vertisol mázico: Presenta una estructura masiva con una consistencia dura o muy dura 

en los 20 cm superiores del suelo. 

 

5.1.4. Fisiografía 

De acuerdo con INEGI (2001), el área de estudio se ubica en la Provincia Fisiográfica 

Sierra Madre del sur, dentro de las subprovincias Mixteca Alta (68.53% de la superficie), 

Sierras Centrales de Oaxaca (27.64%) y un 3.83% de la Cordillera central del sur (Cuadro 

3). En la Figura 6 se observa la distribución geográfica de las subprovincias; las sierras 

centrales se ubican principalmente al noreste, este y en una pequeña porción al noroeste; 

la cordillera costera del sur se observa principalmente al suroeste del área de estudio. 
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Figura 6. Fisiografía del área de estudio (INEGI, 2004). 
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5.1.4.1. Provincia Fisiográfica Sierra Madre del Sur 

 

Esta provincia se ubica de noreste a sureste, paralela y próxima a la costa del pacifico. 

Sus elevaciones son muy constantes, superiores a 2000 m, y sus corrientes escurren al 

océano Pacifico; sobresaliendo los ríos Balsas, Verde y Tehuantepec. 

Esta provincia presenta una marcada complejidad geológica y su material geológico va 

de rocas ígneas, sedimentarias y metamórficas. El origen de este sistema fisiográfico es 

producto del choque de las placas tectónicas de cocos con la de Norteamérica, 

generando el levantamiento de la sierra y su gran complejidad geológica. 

 
Cuadro 3. Provincias fisiográficas. 

Descripción Área (km2) Área (%) 

Cordillera Costera del Sur 236.50 3.83 

Sierras Centrales de Oaxaca 1,704.71 27.64 

Mixteca Alta 4,226.25 68.53 

Total general 6,167.46 100.00 

 

5.1.4.2. Subprovincia Cordillera Costera del Sur 

 

Esta subprovincia la constituyen una serie de sierras que pasan por las costas de 

Michoacán, Guerrero y Oaxaca. Se ubica sobre la subducción de la placa de cocos, lo 

que le confiere una geología compleja; con la presencia de calizas al oeste, ígneas 

intrusivas al norte, ígneas extrusivas e intrusivas al oriente y una importante cantidad de 

metamórficas al este. Entre la sierra se encuentran valles angostos, laderas escarpadas 

y algunas mesetas con aluvión antiguo. Los afluentes sobresalientes, en la porción 

oaxaqueña, son: el río Mixteco, al norte; el río verde (con tributarios como el Atoyac, 

Cuanana, río Grande y Atoyaquillo), al centro-sur; y el Colotepec, al sureste (INEGI, 

2004). 
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5.1.4.3. Subprovincia Mixteca Alta 

 

Las ciudades de Huajuapan de León, Tamazulápam del Progreso y Tlaxiaco se ubican 

en esta subprovincia. En el centro de esta subprovincia se ubica el complejo sierra baja, 

formado de calizas del cretácico. En la parte norte el paisaje lo componen mesetas, 

lomeríos (con aluviones antiguos) y pequeños valles. En la parte este se extiende el valle 

de Santo Domingo Yanhuitlán; compuesto de materiales arcillosos, de origen lacustre 

del terciario inferior, y afectado una erosión hídrica severa atribuida a procesos 

geológicos y mal manejo antropogénico (INEGI, 2004). 

 

5.1.4.4. Subprovincia Sierras Centrales de Oaxaca 

 

Esta subprovincia forma parte de los distritos de Huajuapan, Coixtlahuaca, Teotitlán, 

Cuicatlán, Teposcolula, Nochixtlán, Etla, Zaachila, Zimatlán y pequeñas porciones de 

Tlaxiaco y Ejutla. En la parte norte y oeste, de la subprovincia, dominan las rocas 

sedimentarias del Cretácico y en la sur las rocas metamórficas del Precámbrico. En las 

inmediaciones de Nochixtlán, el paisaje se compone de sierras con cumbres tendidas y 

sierras bajas con cañadas complejas (INEGI, 2004). 

 

5.1.5. Hidrología 

En México, la Comisión Nacional del Agua ha delimitado el territorio nacional en 731 

cuenca hidrológicas, agrupa en 37 regiones hidrológicas (RH) y en 13 regiones 

hidrológico Administrativo (RHA). Para el área de estudio (Figura 7 y Cuadro 4), el 

37.72% se ubica en la región hidrológica Balsas (RH18), el 38.28% en la Costa Chica de 

Guerrero (RH20) y el 29% en la Región Papaloapan (RH28).  
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Figura 7. Hidrología del área de estudio (INEGI, 2010). 
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5.1.5.1. Regiones y cuencas hidrológicas 

 

La RH18, Balsas, se conforma de cuencas cerradas y abiertas que drenan al océano 

Pacifico y se conforma por las subregiones, bajo Balsas, medio Balsas y alto Balsas 

(Cuadro 4). En esta última subregión se encuentra la zona de estudio, específicamente 

en la subcuenca del Río Mixteco con una superficie de 2387.74 km2 del área de trabajo. 

La región se caracteriza por la presencia de lluvias estacionales (de mayo a octubre), 

pendientes fuertes, problemas de deforestación y precipitaciones torrenciales; lo cual 

propicia grandes avenidas, erosión severa y arrastre de grandes cantidades de 

sedimentos (CONAGUA. 2011). 

 

La RH28, Papaloapan, cuyo río del mismo nombre, nace en la Mixteca Alta Oaxaqueña 

y recorre, antes de desembocar en el Golfo de México, los estados de Oaxaca y 

Veracruz. El área de estudio cubre 1788.73 km2 de esta región hidrológica. 

 

La RH20, Costa Chica de Guerrero, abarca 1990.99 km2 del área estudio. Dentro de la 

subregión Río Verde, que desemboca en el Océano Pacifico, la mayoría de las corrientes 

fluviales son estacionales, a excepción del Río verde. La región hidrológica se caracteriza 

por la presencia de ciclones tropicales y un régimen de lluvia estacional. Estos eventos 

metrológicos extremos al encontrar terrenos desprovistos de vegetación y pendientes 

pronunciadas generan importantes problemas de erosión hídrica. 

 

 
Cuadro 4. Regiones hidrológicas en el área de estudio. 

Región Subregiones Área (km2) Área (%) 

Balsas Alto Balsas, Bajo Balsas 2,387.74 38.72 

Papaloapan Río Papaloapan 1,788.73 29.00 

Costa Chica de Guerrero Río Verde 1,990.99 32.28 

Total general 6,167.46 100.00 
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5.1.6. Geología 

5.1.6.1. Tipos de rocas 

 

De acuerdo con la cartografía de Servicio Geológico Mexicano (SGM, 2000; SGM, 2001), 

en el Cuadro 5 y Figura 8, las rocas más antiguas en la zona son del Precámbrico y 

cubren el 4.3% de la superficie. Durante el Paleozoico se originaron litologías de 

conglomerados poligénicos de lutita-areniscas, areaniscas-lutitas y caliza-lutitas, que 

cubren el 0.6% del área de estudio. 

Cuadro 5. Geología del área de estudio. 

Era Periodo Edad Litología Roca Formación 
Área 
(km2) 

Cenozoico 
Cuaternario Holoceno 0.011-0.020 Aluvial Sedimentaria No aplicable 403.74 
Terciario 

Eoceno – 
Oligoceno 23-55.8 

Toba andesítica-
Andesita Sedimentaria 1074.30 
Toba andesítica-
Arenisca Híbrida Huajuapan 7.25 

Paleoceno – 
Eoceno 33.9-65.5 

Conglomerado 
poligénico-
Arenisca Sedimentaria Tamazulapan 2,449.58 

Mesozoico 

Cretácico 
Albiano – 
Cenomaniano 

93.5-112 
Caliza 

Sedimentaria 
Miahuatepec 122.67 

Caliza-Dolomía Teposcolula 910.59 
Jurásico 

Turoniano - 
Maastrichtiano 

65.5-93.5 
Caliza-Lutita 

Sedimentaria 
Yucunama 1.88 

Marga-Limolita Tilaltongo 106.41 
Neocomiano – 
Aptiano 99.6-146 Caliza-Lutita Sedimentaria Tlaxiaco 345.53 

Berriasiano 125-130 Lutita-Caliza Sedimentaria Zapotitlán 27.04 
Jurásico 
superior 146-161 Caliza-Lutita Sedimentaria 

Chimeco-
Sabinal 268.89 

Jurásico medio 

161-176 
Arenisca-Lutita Sedimentaria Tecocoyunca 134.36 
Arenisca-Toba 
andesítica Híbrida Tecomzachil 4.74 

Paleozoico-
Mesozoico 

Pérmico-
Triásico 

Pérmico – 
Triásico 200-299 

Conglomerado 
poligénico Sedimentaria Yododeñe 1.29 

Paleozoico 
Carbonífero-
Pérmico 

Carbonífero-
Pérmico 

251-359 
Lutita-Arenisca 

Sedimentaria 

Ixcaltepec 13.09 

 Arenisca-Lutita Matzitzi 21.34 

 

Cámbrico-
Ordovícico 

Cámbrico-
Ordovícico 444-542 Caliza-Lutita Sedimentaria Tiñú 2.09 

Precámbrico-
Paleozoico 

Proterozoico-
Devónico 

Proterozoico-
Devónico 359-542 Metasedimentario metamórfica 

Complejo 
Acatlán 208.01 

Precámbrico Proterozoico 
Proterozoico 
medio 1200-1400 

Complejo 
metamórfico metamórfica 

Complejo 
Oaxaqueño 54.59 

No aplicable No aplicable No aplicable  No aplicable No aplicable No aplicable 10.08 

Total general             6,167.46 
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El 31.2% de la superficie bajo estudio corresponde al mesozoico, con materiales como 

caliza, calizas con dolomía, calizas-lutitas, marga-limolita, lutita-caliza, arenisca-lutita, 

arenisca y toba andesítica. Las primeras calizas, con una de edad entre 93.5 a 112 

millones de años, son las más recientes y corresponden al periodo cretácico. 

 

Durante el periodo reciente (era cenozoica), se formó el 63.8% de la litología del área de 

estudio, resultando materiales producto de erupciones volcánicas y arrastres aluviales 

proveniente de toba andesítica-andesita, toba andesítica-arenisca y conglomerados 

poligénico-arenisca. Dichos conglomerados se componen de materiales gruesos que se 

han acumulado en las partes bajas producto de la erosión de las partes más altas. 
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Figura 8. Geología del área de estudio (SGM, 2000; SGM 2001). 
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5.1.6.2. Estratigrafía regional 

 

En el área de estudio, y sus cercanías, se presentan las siguientes formaciones 

estratigráficas: Tiñú, Tecomazuchitl, Matzitzi, Ixtaltepec, Yododeñe, Tecocoyunca, 

Chimeco-Sabinal, Zapotitlán, Tlaxiaco, Tilaltongo, Yucunama, Teposcolula, 

Tamazulapam y Huajuapan (Figura 10). 

 

La formación Tiñú es una secuencia de calizas, lutitas, limolitas y areniscas, que afloran 

al sureste de Nochixtlán, en el poblado de Santa María Tiñú y en la región de Santiago 

Ixtaltepec al noreste de Nochixtlán (Pantoja-Alor, 1970). La litología en el área de estudio 

es caliza-lutita con una edad de 445 a 542 millones de años de la era Paleozoica entre 

los periodos Cámbrico-Ordovícico. 

 

La formación Tecomazuchitl se formó durante el Jurásico medio, es una secuencia 

continental nombrada lechos rojos, integrada por intercalaciones de arenisca, lutitas y 

conglomerados que cubren de forma discontinua las rocas metamórficas del terreno 

Mixteco, afloran en las cercanías de Texacalapa, Puebla en el río Tecomazúchil (Pérez-

Ibargüengoitia et al., 1965). 

 

La formación Matzitzi se localiza cerca del poblado de Xochiltepec, al sureste de 

Tehuacán Puebla, la cual es descrita como roca con una importante cantidad de plantas 

del jurásico, está formada por areniscas de color crema de grano medio a grueso, por 

estratos o paquetes de estratos de lutita, dolomita carbonosa, arenisca conglomerática y 

conglomerado, en menor cantidad existen capas de carbón. Por la presencia de restos 

fósiles de plantas se asume que esto ocurrieron en un ambiente sedimentario pantanoso 

costero (Silva, 1970). Las areniscas del área de estudio tienen una edad de 251-359 

millones de años, perteneciente en la era paleozoica durante el periodo Carbonífero-

Pérmico. 



 

34 

La formación Ixtaltepec aflora a aproximadamente a 16 km al noreste de Asunción 

Nochixtlán y a 500 m al norte del poblado de Santiago. Es formación presenta una 

secuencia de rocas clásicas marinas integrada por lutitas limolitas y areniscas, con 

intercalaciones de calizas (Pantoja-Alor, 1970), de la era paleozoica, edad Carbonífero-

Pérmico, misisípicas, pensilvánicas. 

 

La Formación Yododeñe se compone de una secuencia de conglomerados gruesos 

intercalados con areniscas y limolitas del Carbonífero temprano-tardío o del Pérmico 

medio, que afloran sobre el arroyo Yododeñe. La litología está integrada por rocas 

metamórficas y sedimentarias, conglomerado poligénicos, lutitas y arenisca de color rojo 

(Pantoja-Alor, 1970). 

 

La formación Tecocoyunca está constituida por una secuencia de estratos, cuya parte 

inferior es de origen continental, la parte intermedia se presentan intercalaciones marinas 

y en la parte superior se observan estratos marinos. La litología se conforma por 

areniscas, limolitas y lutitas. En la parte superior son lutitas de color gris con abundante 

yeso secundario. Este grupo descansa sobre el conglomerado Cualac (Erben, 1956) del 

jurásico medio. 

 

La formación Chimeco-Sabinal, está integrada por rocas calizas, lutita, limolita, y del 

Jurásico superior (López-Ticha, 1985). La formación Chimeco se formó en un ambiente 

lacustre, y la Sabinal en un ambiente marino profundo bajo condiciones reductoras. 

La formación Zapotitlán corresponde a depósitos de amiente marino, esto lo evidencia la 

presencia de horizontes areno-calcáreos. Su litología se integra por lutita, caliza, 

arenisca verdosa y algunos horizontes conglomeráticos, además de calcáreos 

alternados con lutita y arenisca (Hernández-Estévez, 1980). 
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La formación Tlaxiaco aflora en la porción sur y centro de la cuenca de Tlaxiaco. La 

litología consiste en calizas, areniscas calcáreas, lutitas calcáreas de color negro de la 

era cenozoica y periodo jurásico Barremiano-Aptiano considerado de origen marino 

(López-Ticha, 1985). 

 

La formación Tilaltongo, propuesta por Salas en 1949, se compone de rocas calcáreas-

arcillosas que afloran en la región de Tilantongo, Oaxaca. Su litología está compuesta 

por lutitas, arenisca y calizas arcillosas que datan de la era mesozoica del periodo 

jurásico Turoniano-Maestrichtiano, cuyo ambiente de depósito fue una cuenca marina 

(Ortega-González y Lambarria-Silva, 1991). 

 

La formación Yucunama, propuesta por Ferrusquía-Villafranca (1976), se compone de 

calizas margosas de color crema que afloran en San Pedro Yucunama. Estos depósitos, 

formados en un ambiente de plataforma interna semiprofunda, son de roca calcáreo-

arcillosas con aspecto conglomerático e intercalaciones de areniscas y lutitas, cuya edad 

data del Turoniano-Campaniano e incluso hasta el Maastrichtiano (Ferrusquía-

Villafranca, 1976). 

La formación Teposcolula, nombrada por Caballero-Miranda (1990), está formada por 

calizas carbonatadas con intercalaciones de estratos de dolomías y calizas arcillosas 

(Ortega-González y Lambarria-Silva, 1991). En esta formación se generan estructuras 

de erosión por disolución llamada lapiaz (erosión en canalillos por disolución de la roca). 

Se formó durante la era mesozoica, durante el cretácico en la edad del Albiano - 

Cenomaniano, en un ambiente de facies de plataforma. 

La formación Tamazulapam se depositó en un ambiente continental sobre la formación 

Yanhuitlán y la cuenca formada en un flanco del anticlinal de Teposcolula. Aflora al 

noroeste del anticlinorio de Teposcolula (Ferrusquía-Villafranca, 1976) como un 

conglomerado integrado por fracciones de calizas con matriz arenosa de color rojizo. 

Esta formación tiene una edad que data de la era cenozoica, del periodo terciario del 

paleoceno – eoceno. 
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La formación Huajuapan fue nombrada por Salas en 1949 como Capas de Huajuapan 

debido a las capas interestratificadas de arenisca, cenizas volcánicas, arcillas, arena y 

capas de conglomerados. Fue en 1956 cuando Erben la denominó formación Huajuapan 

y la subdividió en tres partes. La primera matriz al norte de Chila de las Flores con calizas 

calcáreas y al oeste de Huajuapan de León sobre las barrancas de la Estancia. La 

segunda matriz conformada por depósitos vulcano-sedimentarios hacia Zapotitlán, en 

Palmas-Huajuapan con conglomerados calcáreos y en su cima con capas de limo-

arenosas tobaceas de colores rojos, rosas y verdes. La tercera parte corresponde a una 

matriz arenosa de color rojizo bien cementada. La edad de esta formación es de la era 

Cenozoica terciaria del Eoceno – Oligoceno. 

 

5.1.6.3. Falla Tamazulapam. 

La estratigrafía del área de estudio es controlada principalmente por la falla de 

Tamazulapan que la cruza longitudinalmente entre rocas del cretácico y terciario (¡Error! 

o se encuentra el origen de la referencia.). Esta falla se localiza en el extremo oeste 

del anticlinal Tamazulapam, partiendo del poblado de Tamazulapam, hasta Santa María 

Yolotepec. Presenta un desarrollo de más de 100 km, rumbo promedio Norte- Sur, una 

inclinación de 20° hacia el poniente y presenta planos de falla con movimientos normal y 

lateral derecha (Figura 9). En su porción norte está en contacto con las formaciones 

Teposcolula y Tamazulapam; donde los depósitos de esta última formación se localizan 

en la cuenca formada a un lado del anticlinal (Santamaría-Díaz et al., 2008). 

 

 
Figura 9. Perfil estratigráfico de la Mixteca Oaxaqueña (Santamaría - Díaz, 2009). 
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Figura 10. Formaciones y estructuras geológicas del área de estudio (SGM, 2000). 
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5.1.7. Uso de suelo y vegetación 

De acuerdo con uso de suelo y vegetación, realizado por la WWF (2014), la zona de 

estudio cuenta con 15 tipos de cubiertas. Los pastizales ocupan el primer lugar (20.99%), 

con importantes áreas con problema de cárcavas. El segundo lugar corresponde al 

bosque de encino (19.11%), seguido por bosque de pino–encino (incluyendo encino pino) 

con 16.60%), agrícola (12.92%), matorral (12.12%), el resto ocupa una proporción menor 

al 10% (Cuadro 6, Figura 11). 

 
Cuadro 6. Uso de suelo y vegetación. 

 

 

Es importante mencionar que la mayor parte del área afectada por cárcavas está ubicada 

en porciones de pastizales y matorrales, específicamente en las transiciones con bosque 

de encino y encino–pino. 

Uso de suelo y vegetación Área (km2) Área (%) 

Área Agrícola 796.55 12.92 

Área Impactada por Incendio 0.84 0.01 

Área sin Vegetación Aparente 70.52 1.14 

Asentamientos Humanos 58.84 0.95 

Bosque de coníferas 468.39 7.59 

Bosque de encino 1,178.60 19.11 

Bosque de Pino-Encino (incluye encino-pino) 1,023.78 16.60 

Bosque mesófilo de montaña 4.25 0.07 

Chaparral 92.09 1.49 

Cuerpos de Agua 5.69 0.09 

Matorral 747.27 12.12 

Palmar 7.99 0.13 

Pastizales 1,294.41 20.99 

Plantación Forestal 2.11 0.03 

Selva baja caducifolia 416.13 6.75 

Total general 6,167.46 100.00 
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Figura 11. Uso de suelo y vegetación (WWF, 2014). 
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5.2. Materiales 

Para la elaboración de esta investigación se utilizaron los siguientes materiales: 

 Modelo de elevación digital, tamaño de pixel 15X15 (INEGI, 2012). 

 Capa vectorial de suelos del área de estudio (INEGI, 2006). 

 Capa vectorial con distribución regional de climas (INEGI, 2008). 

 Capa vectorial de unidades fisiográficas (INEGI, 2001).  

 Capa vectorial de uso de suelo y vegetación elaborada por (WWF, 2014). 

 Cartas geológico-minera (E14-6, E14-9 y E14-12) del (SGM, 2000; SGM, 2001). 

Escala 1: 250 000. 

 Imágenes multiespectrales Spot 6 Y 7, con una resolución 6X6m, fechas de toma 

4/Nov/2015, 16/Feb/2015 y 29/Ene/2015, (CNES, 2015). (CNES, 2015). 

 Información climatológica del área de estudio y sus inmediaciones (IMTA, 2009).  

 Capa vectorial con localización de las estaciones climatológicas (CONAGUA, 

2016). 

 Software ArcGis 10 (ESRI, 2010) 

 Software QGIS 2.8.1 (OSGeo, 2015) 

 Software R-3.2.3 (GNU General Public License, 2015) 

 Software Google Earth Pro (Gobierno de EE.UU) 

 Computadora Gateway, modelo NV59C, procesador Intel® Core ™ i5 CPU M480 

@2.67GHz, sistema operativo 64bits. 
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5.3. Métodos 

En la Figura 12 se ilustra, se ilustra, de manera general y en forma de diagrama de flujo, 

la metodología seguida en esta investigación. A continuación, se describen las diferentes 

etapas que se abordaron. 

 

 Recopilación y análisis 

Se revisaron artículos científicos, folletos, tesis y otros documentos para integrar el marco 

teórico, la caracterización biofísica y selección de variables. 

 

Se revisó la información cartográfica existente de las fuentes oficiales como Instituto 

Nacional de Estadística y Geografía (INEGI), Comisión Nacional del Agua (CONAGUA), 

Servicio Geológico Mexicano (SGM) y World Widllife Fund (WWF), con el fin integrar el 

sistema de información geográfica del área de estudio. 

 

La información de suelos, en formato shapefile (shp), se obtuvo del INEGI (2006 con las 

siguientes características: sistema de proyección Cónica Conforme de Lambert, paralelo 

estándar 1: 17.5, paralelo estándar 2: 29.5, longitud del meridiano central: -102.0, latitud 

de origen de la proyección: 12, falso oeste: 2, 500 000 y falso norte: 0. La clasificación 

de suelos reportada se basa en el Sistema Internacional Base Referencial Mundial del 

Recurso Suelo (WRB, 2006). 
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Figura 12. Diagrama de flujo de la metodología de trabajo. 
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Las unidades climáticas se obtuvieron de los datos vectoriales del INEGI (2008) en 

proyección Cónica Conforme de Lambert (CCL) y formato shapefile. Las unidades de los 

climas reportadas se basan en la modificación propuesta por Enriqueta García al sistema 

de clasificación climática Köppen (García, 2004). 

 

La fisiografía, basada en las formas del relieve, origen geológico y litología, se obtuvo de 

los datos vectoriales del INEGI (2001). Estos vectores se reportan en formato shapefile, 

sistema de proyección Cónica Conforme de Lambert, datum ITRF 92 y se agrupan por 

provincias fisiográficas, subprovincias y sistemas de topoformas.  

 

El uso de suelo y vegetación se obtuvo de la capa vectorial de uso de suelo y vegetación 

realizado por la WWF (2014); elaborada a partir de la clasificación supervisada de 

imágenes de satélite Spot 5 del año 2010 y resolución de 5 m. 

 

La geología se obtuvo de las cartas Geológico-minero del SGM (2000, 2001). Las cartas 

consultadas fueron la E14-6 (Orizaba, Veracruz), E14-9 (Oaxaca, Oaxaca) y E14-12 

(Zaachila, Oaxaca). Estas cartas se pasaron de formato pdf (Portable Document Format) 

a tif (Tagged Image File Format) y la imagen resultante, para su digitalización en formato 

vectorial (shapefile), se referenció en el sistema de información Qgis. 

 

 Recopilación de información de relieve 

El modelo de elevación digital de la superficie del terreno se obtuvo de INEGI (2012), con 

resolución de pixel de 15x15 m y valores de elevación en metros. La referencia geodésica 

de esta información es: ITRF92 época 1988.0, elipsoide GRS80 y coordenadas 

geográficas. Esta información se transformó al sistema Universal Transveral de Mercator 

(UTM) y esferoide WGS84 Zona 14, como se trata d raster3 con datos continuos, este se 

                                                           
3 Raster: Es una matriz de celdas organizadas en filas y columnas en la que cada celda representa un valor, estos 
pueden ser imágenes de satélite, fotografías áreas, modelos de elevación digital e incluso mapas escaneados. 
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remuestreó con el procedimiento de convolución cúbica; el cual utiliza 16 centros, de las 

celdas más cercanas, para interpolar el valor de salida (Figura 13). 

 
Figura 13. Remuestreo del modelo de elevación. 

 

 Recopilación de información satelital 

Se usaron las imágenes Google Earth Pro para ubicar polígonos de reconocimiento en 

campo y generar polígonos, en formato shapefile, de cárcavas. 

 

Al gestor autorizado del Colegio de Postgraduados se le solicitaron 24 imágenes de los 

satélites SPOT 6 y 7 provenientes de la Estación Receptora del sistema ERMEX, 

localizada en Santa María Rayón, México. Del total de imágenes solicitadas, 4 

corresponden al sensor SPOT 6 y 20 al SPOT 7. Estas imágenes multiespectrales, en 

formato JP2, tienen una resolución 6 metros y se conforman por cuatro bandas; donde 

la banda 0 corresponde al espectro azul, la 1 al verde, la 2 al rojo y la 3 al infrarrojo 

cercano. 

 

Se seleccionaron las imágenes de la estación seca y con las fechas de toma más 

cercanas. Con estos criterios, se seleccionaron 3 imágenes del Spot 7 (dos del 29 de 

enero del 2015 y una del 4 de noviembre de 2015) y 3 del Spot 6, con la fecha de toma 

del 16 de febrero de 2015 (Figura 14). 
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Figura 14. Imágenes Spot usadas. 

 

 Recopilación de información de campo 

Se realizaron recorridos de campo para el reconocimiento del área de estudio. Con las 

coordenadas de las cárcavas, identificadas en campo, se ingresó a las imágenes de 

Google Earth y se capturaron los polígonos con presencia de cárcavas; los cuales se 

usuraron posteriormente para asistir la clasificación supervisada. 
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En total se visitaron 17 puntos en campo, entre el 8 y 10 de diciembre de 2015, para 

observar los controles ambientales e identificar el material geológico donde se generan 

las cárcavas (Figura 15 y Cuadro 7).  

 
Cuadro 7.Ubicación de los sitios visitados en campo. 

Sitio Nombre Latitud Longitud 

1 Dos Corazones 17°32'28.34"N 97°22'10.32"W 

2 Yanhuitlán Parte Alta 17°32'49.73"N 97°19'36.46"W 

3 Yanhuitlán 17°31'53.32"N 97°20'10.07"W 

4 Santo Domingo Tlatayacapan 1 17°25'7.25"N 97°19'59.58"W 

5 Santo Domingo Tlatayacapan 2 17°23'32.45"N 97°20'54.77"W 

6 San Francisco Nuxaño 17°21'57.30"N 97°21'7.44"W 

7 Desviación Tlaxiaco 17°34'27.52"N 97°25'22.55"W 

8 Santa Catarina Tayata 17°21'44.46"N 97°34'53.73"W 

9 San Agustín Tlacotepec 17°12'49.15"N 97°30'20.37"W 

10 San Mateo Peñasco 17°10'30.70"N 97°32'9.36"W 

11 Magdalena Peñasco 17°13'16.75"N 97°32'26.55"W 

12 Santiago Yolomecatl 17°27'27.98"N 97°34'29.47"W 

13 Magdalena Zahuatlán 1 17°23'59.05"N 97°13'12.59"W 

14 Magdalena Zahuatlán 2 17°24'8.27"N 97°12'24.26"W 

15 Etlatongo 17°25'56.55"N 97°12'42.76"W 

16 San José Monteverde 17°38'24.60"N 97°20'0.09"W 

17 San José Monteverde 17°38'50.80"N 97°20'57.94"W 
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Figura 15. Sitios de reconocimiento en campo. 
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A continuación, se describe brevemente las condiciones biofísicas que presenta cada 

uno de los sitios visitados y que fueron utilizados como áreas de entrenamiento para la 

clasificación supervisada. 

 

Sitio 1. “Dos Corazones”, se ubica en la provincia Sierra Madre del Sur, en la 

subprovincia Mixteca Alta, en la región hidrológica 20, Costa Chica – Río verde, en la 

cuenca Atoyac y subcuenca Río Sordo. Los materiales geológicos datan de la era 

Cenozoica terciaria, con rocas sedimentarias de litología, conglomerado poligénico- 

arenisca, perteneciente a la Formación Tamazulapan, con un clima actual templado 

subhúmedo, en las áreas aledañas se puede el suelo leptosol calcárico con textura fina, 

con sistemas de topoformas valles de laderas tendidas con lomerío, el uso de suelo es 

una transición entre bosque de encino y matorral.  

 

En la Figura 16, se ilustran las dos cárcavas más importantes, por parecer dos corazones 

se le denominada de este modo. Las personas de este lugar comentan que los 

desgajamientos de los taludes se vienen dando de forma muy lenta de manera natural. 

Para contrarrestar la formación de cárcavas, en las partes bajas, los habitantes han 

acomodado piedra en estas y practicado la técnica de lama bordo. 

  
Figura 16. Fotografías del sitio 1. 
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Sitio 2. “Yanhuitlán Parte Alta”, se ubica en la provincia Sierra Madre del Sur, en la 

subprovincia Mixteca Alta, en la región hidrológica Costa Chica – Río verde, en la cuenca 

Atoyac y subcuenca Río Sordo. Los materiales geológicos datan de la era Cenozoica 

terciaria, con rocas sedimentarias de litología, conglomerado poligénico- arenisca, 

perteneciente a la Formación Tamazulapan, con un clima actual templado subhúmedo, 

en las áreas aledañas se observa suelo leptosol calcárico con textura fina, con sistemas 

de topoformas sierra baja compleja con cañadas, el uso de suelo matorral xerófilo (Figura 

17). 

 

  
Figura 17. Fotografías del sitio 2. 

 

Sitio 3. “Yanhuitlán”, se ubica en la provincia Sierra Madre del Sur, en la subprovincia 

Mixteca Alta, en la región hidrológica 20, Costa Chica – Río verde, en la cuenca Atoyac 

y subcuenca Río Sordo. Los materiales geológicos datan de la era Cenozoica 

cuaternario, materiales aluviales sedimentarios, con un clima actual templado 

subhúmedo, en las áreas aledañas se observa suelo vertisol mázico con textura media, 

con sistemas de topoformas valles de laderas tendidas con lomerío, el uso de suelo es 

matorral xerófilo ( Figura 18). 
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Figura 18. Fotografías del sitio 3. 

 

Sitio 4. “Santo Domingo Tlatayacapan 1”, se ubica en la provincia Sierra Madre del 

Sur, en la subprovincia Mixteca Alta, en la región hidrológica 20, Costa Chica – Río verde, 

en la cuenca Atoyac y subcuenca Río Sordo. Los materiales geológicos datan de la era 

Cenozoica terciaria, con rocas sedimentarias de litología, conglomerado poligénico - 

arenisca, perteneciente a la Formación Tamazulapan, con un clima actual templado 

subhúmedo, en las áreas aledañas se observa el suelo Phaeozem calcárico con textura 

fina, con sistemas de topoformas sierra baja compleja con cañadas, el uso de suelo es 

pastizal (Figura 19). 
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Figura 19. Fotografías del sitio 4. 

 

Sitio 5. “Santo Domingo Tlatayacapan 2”, se ubica en la provincia Sierra Madre del 

Sur, en la subprovincia Mixteca Alta, en la región 20, hidrológica Costa Chica – Río verde, 

en la cuenca Atoyac y subcuenca Río Sordo. Los materiales geológicos datan de la era 

Cenozoica terciaria, con rocas sedimentarias de litología, conglomerado poligénico - 

arenisca, perteneciente a la Formación Tamazulapan, con un clima actual templado 

subhúmedo, en las áreas aledañas el suelo es luvisol ródico con textura fina, con 

sistemas de topoformas sierra baja compleja con cañadas, el uso de suelo es pastizal 

(Figura 20). 
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Figura 20. Fotografías del sitio 5. 

 

Sitio 6. “San Francisco Nuxaño”, se ubica en la provincia Sierra Madre del Sur, en la 

subprovincia Mixteca Alta, en la región hidrológica 20, Costa Chica – Río verde, en la 

cuenca Atoyac y subcuenca Río Sordo. Los materiales geológicos datan de la era 

Cenozoica terciaria, con rocas sedimentarias de litología, conglomerado poligénico- 

arenisca, perteneciente a la Formación Tamazulapan, con un clima actual templado 

subhúmedo, el suelo en las áreas aledañas es luvisol ródico con textura fina, con 

sistemas de topoformas sierra baja compleja con cañadas, el uso de suelo es pastizal 

(Figura 21). 
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Figura 21. Fotografías del sitio 6. 

 

Sitio 7. “Desviación Tlaxiaco”, se ubica en la provincia Sierra Madre del Sur, en la 

subprovincia Mixteca Alta, en la región hidrológica 18, Balsas, en la cuenca Atoyac y 

subcuenca Río Mixteco. Los materiales geológicos datan de la era Cenozoica terciaria, 

con rocas sedimentarias de litología, conglomerado poligénico- arenisca, perteneciente 

a la Formación Tamazulapan, con un clima actual templado subhúmedo, en las áreas 

aledañas se encuentran Leptosoles con textura fina, con sistemas de topoformas sierra 

baja compleja con cañadas, el uso de suelo es área sin vegetación aparente. Los tipos 

de materiales parentales que el sitio se ilustra en la Figura 22. 
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Figura 22. Fotografías del sitio 7. 

 

Sitio 8. “Santa Catarina Tayata”, se ubica en la provincia Sierra Madre del Sur, en la 

subprovincia Mixteca Alta, en la región hidrológica 20, Costa Chica – Río verde, en la 

cuenca Atoyac y subcuenca Río Sordo. Los materiales geológicos datan de la era 

Cenozoica terciaria, con rocas sedimentarias de litología, conglomerado poligénico- 

arenisca, perteneciente a la Formación Tamazulapan, con un clima actual templado 

subhúmedo, el suelo en las áreas aledañas es leptosol con textura fina, con sistemas de 

topoformas lomerío con cañadas, el uso de suelo es pastizal (Figura 23). 
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Figura 23. Fotografías del sitio 8. 

 

Sitio 9. “San Agustín Tlacotepec”, se ubica en la provincia Sierra Madre del Sur, en la 

subprovincia Mixteca Alta, en la región hidrológica 20, Costa Chica – Río verde, en la 

cuenca Atoyac y subcuenca Río Sordo. Los materiales geológicos datan de la era 

Cenozoica terciaria, con rocas sedimentarias de litología, conglomerado poligénico- 

arenisca, perteneciente a la Formación Tamazulapan, con un clima actual templado 

subhúmedo, en las áreas aledañas se encuentran regosoles de textura media y fase 

física pedregosa, con sistemas de topoformas sierra alta compleja, el uso de suelo es 

pastizal. La variación de colores de los materiales geológicos se precia en la Figura 24. 
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Figura 24. Fotografías del sitio 9. 

 

Sitio 10. “San Mateo Peñasco”, se ubica en la provincia Sierra Madre del Sur, en la 

subprovincia Mixteca Alta, en la región hidrológica 20, Costa Chica – Río verde, en la 

cuenca Atoyac y subcuenca Río Sordo. Los materiales geológicos datan de la era 

Cenozoica terciaria, con rocas sedimentarias de litología, conglomerado poligénico- 

arenisca, perteneciente a la Formación Tamazulapan, con un clima actual templado 

subhúmedo, los suelos en las áreas aledañas son regosoles de textura media y fase 

física pedregosa, con sistemas de topoformas sierra alta compleja, el uso de suelo es 

pastizal. La Figura 25 se observa la acumulación de materiales calcáreos en el perfil del 

material residual expuesto. 
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Figura 25. Fotografías del sitio 10. 

 

 

Sitio 11. “Magdalena Peñasco”, se ubica en la provincia Sierra Madre del Sur, en la 

subprovincia Mixteca Alta, en la región hidrológica 20, Costa Chica – Río verde, en la 

cuenca Atoyac y subcuenca Río Sordo. Los materiales geológicos datan de la era 

Cenozoica terciaria, con rocas sedimentarias de litología, conglomerado poligénico- 

arenisca, perteneciente a la Formación Tamazulapan, con un clima actual templado 

subhúmedo, el suelo en las áreas aledañas es Leptosol de textura fina, con sistemas de 

topoformas sierra alta compleja, el uso de suelo es pastizal. El sitio 11 es uno de los 

paisajes donde sería complicado introducir obras mecánicas de conservación de suelos 

ya que las dimensiones de las cárcavas son profundas y los flujos de agua alcanzan altas 

velocidades (Figura 26). 
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Figura 26. Fotografías del sitio 11. 

 

Sitio 12. “Santiago Yolomecatl”, se ubica en la provincia Sierra Madre del Sur, en la 

subprovincia Mixteca Alta, en la región hidrológica 18, Balsas, en la cuenca Atoyac y 

subcuenca Río Mixteco. Los materiales geológicos datan de la era Cenozoica 

cuaternaria, con rocas sedimentarias de litología, material aluvial, con un clima actual 

templado subhúmedo, en las áreas aledañas el suelo es un Luvisol profóndico con 

textura fina, con sistemas de topoformas lomerío con cañadas, el uso de suelo es 

pastizal. En la Figura 27, se aprecia que son materiales acumulados, en forma fluvial, 

ahora están siendo expuestos a un nuevo proceso erosivo. 
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Figura 27. Fotografías del sitio 12. 

 

Sitio 13. “Magdalena Zahuatlan 1”, se ubica en la provincia Sierra Madre del Sur, en la 

subprovincia Sierras centrales de Oaxaca, en la región hidrológica 20, Costa Chica – Río 

verde, en la cuenca Atoyac y subcuenca Río Sordo. Los materiales geológicos datan de 

la era Cenozoica terciario, con rocas sedimentarias de litología, conglomerado 

poligénico- arenisca, perteneciente a la Formación Tamazulapan, con un clima actual 

semiseco templado, el suelo en las áreas aledañas es el Luvisol crómico de textura 

media, con sistemas de topoformas sierra baja compleja con cañadas, el uso de suelo 

es pastizal. En la Figura 28 se aprecian materiales parentales derivados de cenizas 

volcánicas, que pertenecen a diferentes periodos de acumulación. 
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Figura 28. Fotografías del sitio 13. 

 

Sitio 14. “Magdalena Zahuatlan 2”, se ubica en la provincia Sierra Madre del Sur, en la 

subprovincia Sierras centrales de Oaxaca, en la región hidrológica 20, Costa Chica – Río 

verde, en la cuenca Atoyac y subcuenca Río Sordo. Los materiales geológicos datan de 

la era Cenozoica terciario, con rocas sedimentarias de litología, conglomerado 

poligénico- arenisca, perteneciente a la Formación Tamazulapan, con un clima actual 

semiseco templado, en las áreas aledañas el suelo es el Luvisol crómico de textura 

media, con sistemas de topoformas sierra baja compleja con cañadas, el uso de suelo 

es pastizal. La Figura 29, muestra alguna de las cárcavas típicas de este sitio. 
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Figura 29. Fotografías del sitio 14. 

 

Sitio 15. “Etlatongo”, se ubica en la provincia Sierra Madre del Sur, en la subprovincia 

Sierras centrales de Oaxaca, en la región hidrológica 20, Costa Chica – Río verde, en la 

cuenca Atoyac y subcuenca Río Sordo. Los materiales geológicos datan de la era 

Cenozoica terciario, con rocas sedimentarias de litología, conglomerado poligénico- 

arenisca, perteneciente a la Formación Tamazulapan, con un clima actual semiseco 

templado, en las áreas aledañas el suelo es el Luvisol crómico de textura media, con 

sistemas de topoformas sierra baja compleja con cañadas, el uso de suelo es pastizal. 

En la Figura 30 se observa que el agente erosivo es el agua, en algunos casos forma 

túneles que posteriormente se deprenden estos materiales de las cabeceras. 
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Figura 30. Fotografías del sitio 15. 

 

Sitio 16. “San José Monteverde”, se ubica en la provincia Sierra Madre del Sur, en la 

subprovincia Mixteca alta, en la región hidrológica 28, Papaloapan, en la cuenca 

Papaloapan y subcuenca Río Salado. Los materiales geológicos datan de la era 

Cenozoica terciario, con rocas sedimentarias de litología, conglomerado poligénico- 

arenisca, perteneciente a la Formación Tamazulapan, con un clima actual templado 

subhúmedo, en las áreas aledañas el suelo es leptosol calcárico de textura fina, con 

sistemas de topoformas sierra baja compleja con cañadas, el uso de suelo es matorral 

xerófilo. En la parte donde no hay presencia de cárcavas, la superficie está protegida por 
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una capa delgada de materiales carbonatados. Se observa que la formación de las 

cárcavas es producto de cambios geológicos y climáticos que poco a poco han ido 

desgastando esta capa hasta formar cárcavas como las mostradas en la Figura 31. 

 
Figura 31. Fotografías del sitio 16. 

 

Sitio 17. “San José Monteverde”, se ubica en la provincia Sierra Madre del Sur, en la 

subprovincia Mixteca alta, en la región hidrológica 28, Papaloapan, en la cuenca 

Papaloapan y subcuenca Río Salado. Los materiales geológicos datan de la era 

Cenozoica terciario, con rocas sedimentarias de litología, conglomerado poligénico- 

arenisca, perteneciente a la Formación Tamazulapan, con un clima actual templado 

subhúmedo, en las áreas aledañas el suelo es leptosol calcárico con textura fina, con 

sistemas de topoformas sierra baja compleja con cañadas, el uso de suelo es matorral 

xerófilo. En la Figura 32, se aprecian que los materiales tienen una fragilidad alta a la 

degradación causada por movimientos tectónicos y agentes hidroclimáticos. 
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Figura 32. Fotografías del sitio 17. 

 

 

 Obtención de variables 

La selección de variables se hizo en función de lo que reporta la bibliografía y las escalas 

de la información. Inicialmente se planteó trabajar 25 variables, sin embargo, la 

identificación de las cárcavas se realizó con las 10 variables que mostraron mayor 

correlación. Las variables relacionadas con el suelo, como conductividad hidráulica, 

factor K, tipo de suelo y textura fueron descartadas porque la información disponible 
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corresponde a la carta edafológica de INEGI (2006) escala 1:250 000. Las variables 

climáticas como tipo de clima, precipitación, temperatura anual, índice de Fournier, índice 

de Fournier modificado e índice de concentración de la precipitación no se usaron debido 

a que no mostraron una tendencia clara con la distribución de cárcavas. Las variables 

geológicas como tipo de roca, edad del material parental y dureza del material parental 

tampoco se consideraron ya que esta información solo está disponible en mapas con 

escala 1:250 000. Variables de cobertura vegetal como porcentaje de cobertura vegetal, 

no se usó debido a que era redundante con el NDVI, ya que porcentaje se generó a partir 

de NDVI. La información de uso de suelo y vegetación, aun cuando está disponible a 

escala 1:50 000 (WWF, 2014) no fue útil ya que los terrenos con cárcavas fueron 

clasificados como pastizales. Otras variables no consideradas, pues no mostraron 

relación con la presencia de cárcavas fue la densidad de corrientes y orientación 

topográfica. A continuación, se describen las variables que muestran mayor correlación 

con la presencia de cárcavas. 

 

 Variables topográficas 

 

(a) Pendiente 

 

La pendiente en un punto del terreno se define como el ángulo existente entre el vector 

normal a la superficie, en ese punto, y la vertical. La pendiente se puede obtener en 

grados o porcentaje. Su estimación se realiza a partir del MDE y se calcula con la 

pendiente de un plano de ajuste para cada punto o celda del modelo. La pendiente se 

obtuvo en porcentaje con el comando 3D Analyst Tools>Raster Surface>Slope de ArcGis 

10, la cual es calculada mediante la técnica del promedio máximo (Burrough et al., 1998). 

Así, entre mayor es la diferencia de elevaciones el valor de la pendiente es más 

escarpada y cuando más pequeña, la superficie es más plana (Figura 33). 
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𝑃𝑒𝑛𝑑𝑖𝑒𝑛𝑡𝑒 𝑒𝑛 𝑔𝑟𝑎𝑑𝑜𝑠 = θ = tan−1 (
𝐷𝑖𝑓𝑒𝑟𝑒𝑛𝑐𝑖𝑎 𝑑𝑒 𝑒𝑙𝑒𝑣𝑎𝑐𝑖ó𝑛

𝐿𝑜𝑛𝑔𝑖𝑡𝑢𝑑
) 

Ecuación 1. 

𝑃𝑒𝑛𝑑𝑖𝑒𝑛𝑡𝑒 𝑒𝑛 𝑝𝑜𝑟𝑐𝑒𝑛𝑡𝑎𝑗𝑒 = (
𝐷𝑖𝑓𝑒𝑟𝑒𝑛𝑐𝑖𝑎 𝑑𝑒 𝑒𝑙𝑒𝑣𝑎𝑐𝑖ó𝑛

𝐿𝑜𝑛𝑔𝑖𝑡𝑢𝑑
) × 100 

Ecuación 2. 

Cuando la pendiente es 45° en porcentaje es 100 

Figura 33. Representación gráfica de la pendiente. 

 

La pendiente se puede clasificar de diferentes maneras, uno de los criterios más 

utilizados en la geomorfología es el umbral geomorfológico citado por Ferrando (1993), 

el cual se presenta en el Cuadro 8. 

 
Cuadro 8. Clasificación de pendientes (Ferrando, 1993). 

Pendientes 
Tipo de pendiente Umbral geomorfológico 

Grados (°) Porcentaje (%) 

0 - 2 0- 4.5  Plana Erosión nula a leve 

2 - 5 4.5 - 11.0 Suave Erosión débil, difusa. Erosión 
laminar 

5 - 10 11.0 - 22.0 Moderada Erosión moderada a fuerte. Inicio 
de erosión lineal. Erosión en 
surcos 

10 - 20 22.0 - 44.5 Fuerte Erosión intensa. Erosión lineal 
frecuente. Cárcavas incipientes. 

20 - 30 44.5 - 67.0 Muy fuerte a 
Moderadamente 
Escarpada 

Cárcavas frecuentes. Movimiento 
en masa. Deslizamiento de 
materiales 

30 -45 67.0 – 100 Escarpada Deslizamientos. Inicio de 
derrumbes 

>45 >100 Muy Escarpada a 
Acantilada 

Desprendiendo y derrumbes. 
Corredores de Derrumbes 
frecuentes 
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En la Figura 34 se muestra la distribución de la pendiente del terreno según el umbral 

geomorfológico propuesto por Araya y Börgel (1972), Young (1975) y citado por Ferrando 

(1993). Así, para la zona de estudio el 30.14% de la superficie se encuentra en 

pendientes suaves (4.5 -11%), seguido de moderadas, fuerte, planas, modernamente 

escarpada, escapada y muy escarpada; Cuadro 9. 

 

Cuadro 9. Clasificación de pendientes del área de estudio. 

Porcentaje (%) Tipo Área (km2) Área (%) 

0- 4.5  Horizontal 1,046.06 16.96 
4.5 - 11.0 Suave 1,858.88 30.14 
11.0 - 22.0 Moderada 1,849.08 29.98 
22.0 - 44.5 Fuerte 1,153.78 18.71 
44.5 - 67.0 Muy fuerte a Moderadamente 

escarpada 206.49 3.35 
67.0 – 100 Escarpada 49.54 0.80 

>100 Muy Escarpada a Acantilada 3.63 0.06 

Total general   6,167.46 100.00 
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Figura 34. Rangos de pendientes del área de estudio. 
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(b) Curvatura 

 

La curvatura es la tasa de cambio en pendiente, su objetivo es representar la forma que 

toma la pendiente, pude ser cóncava o convexa (Wilson y Gallant, 2000; Zevenbergen 

et al., 1987). La curvatura es el producto de la curvatura plana y de perfil y es una variable 

indispensable para el modelaje de los procesos de erosión y escorrentía (Kienzle, 2004).  

Los valores de curvatura en un área accidentada (relieve moderado) pueden variar de -

0.5 a 0.5, mientras que en montañas escarpadas (relieve extremo) los valores pueden 

variar entre -4 y 4. 

 

(c) Curvatura de perfil o vertical 

 

Indica la magnitud de cambio de la pendiente máxima, en sentido vertical al relieve 

(Moore et al., 1991). Influye en la aceleración o desaceleración del flujo en el terreno; 

valores negativos, en el pixel analizado, indican que la superficie es convexa, por lo tanto, 

la corriente se desacelera; valores positivos de la curvatura corresponden a celdas 

cóncavas y corriente se acelera; un valor igual a 0 indica una superficie lineal sin cambios 

en las condiciones de erosión o depositación (Figura 35).  

 

 

 

 

Figura 35. Tipos de curvatura de perfil o vertical. 
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Con base en la Figura 36, en el Cuadro 10 se observa que el 44.22% de la Mixteca Alta 

se encuentra con un grado de erosión acelerada al presentar una curvatura lateralmente 

convexa, indicativo de la presencia de corrientes con altas velocidades. Por otro parte, 

el 39.34% se ubica en curvatura lateralmente cóncava que representa áreas donde se 

da una desaceleración de flujo y por lo tanto ocurren zonas de depositación de 

sedimentos. Por último, el 16.44% son zonas estables donde no se observa erosión ni 

depositación. 

 

Cuadro 10. Clasificación de curvatura vertical. 

Valores Tipo Área (km2) Área (%) 

<0 Lateralmente cóncava (Erosión desacelerada) 2,426.15 39.34 
0 Superficie lineal (Estable) 1,014.07 16.44 

>0 Lateralmente convexa (Erosión acelerada) 2,727.24 44.22 

Total general 6,167.46 100.00 

 

Los diferentes rangos de curvatura vertical se aprecian en la parte estable corresponde 

a áreas con valores iguales a 0 por lo que es considerada como una superficie estable, 

la parte de color rojo son lateralmente convexa, en esta se genera una erosión acelerada. 
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Figura 36. Curvatura vertical del área de estudio. 

 

(d) Curvatura plana u horizontal. 

Esta curvatura es perpendicular a la pendiente máxima y está relacionada con la 

convergencia o divergencia de los escurrimientos superficiales (Moore et al., 1991). Es 

un indicador del grado de cambio de las condiciones topográficas, en forma horizontal o 

lateral, de una ladera; valores positivos indican una condición lateral, siguiendo una curva 

de nivel, convexa; donde los escurrimientos superficiales tienden a dispersarse a lo largo 
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de la ladera; los valores negativos indican que la superficie es lateralmente cóncava y 

por tanto el escurrimiento superficial se concentra a lo largo de una ladera. Un valor cero 

indica que lateralmente la curva de nivel es lineal y por tanto los escurrimientos 

superficiales bajan paralelos a lo largo de la ladera (Figura 37). 

 

 

 
Figura 37. Tipos de curvatura plana u horizontal. 

 

En el Cuadro 11, se observa que más del 40% del área de estudio tiene curvaturas 

cóncavas, es decir sus escurrimientos son convergentes y sus laderas tienden a producir 

flujos concentrados que incrementan el riesgo de formación de cárcavas. Por otra parte, 

el 38.27% representan una forma convexa y en sus laderas no presentan riesgos de 

acumulación de escurrimientos. El 20.84% restante corresponde a áreas donde las 

corrientes discurren paralelamente. 

 
Cuadro 11. Clasificación de curvatura horizontal. 

Porcentaje (%) Tipo Área (km2) Área (%) 

<0 Convexa (Flujo divergente, corriente desacelerada) 2,360.01 38.27 
0 Plana (Corriente estable) 1,285.22 20.84 

>0 Cóncava (Flujo convergente, corriente acelerada) 2,522.23 40.90 

Total general 6,167.46 100.00 
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Figura 38. Curvatura horizontal del área de estudio. 
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(e) Longitud de la pendiente (λ)  

La longitud de la pendiente (λ) es la distancia entre el punto más alto, de caída de una 

gota de lluvia, y el punto en el cual la pendiente disminuye hasta dar comienzo la 

depositación de sedimentos (Delgado, 2010), es decir, corresponde a la parte donde la 

curvatura vertical de la ladera es convexa (Figura 39). 

 
Figura 39. Longitud de la pendiente. 

Este factor se estimó tomando como base el modelo de elevación de 15X15, con el uso 

de Longitud de la pendiente en SAGA GIS del algoritmo Moore et al. (1991), ubicado en 

Terrain Analysis - Hydrology → Slope Lenght (Figura 40) del Sistema de Información 

Qgis 2.8.1. 

 
Figura 40. Comando para el cálculo de longitud de la pendiente en Qgis. 
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En el área de estudio se tienen longitudes de pendientes que van de 0 a 4395 m, siendo 

más frecuentes los rangos 20-100, 0-20, 100-200, 200-500, (Cuadro 12). 

 
Cuadro 12. Longitud de la pendiente del área de estudio. 

Longitud de la pendiente (m) Área (km2) Área (%) 

0 – 20 1,705.45 27.65 
20 – 100 2,351.76 38.13 
100 – 200 1,178.22 19.10 
200 – 500 776.56 12.59 
500 – 1000 130.02 2.11 
1000 – 2000 22.97 0.37 
2000 – 3000 2.17 0.04 
3000 – 4000 0.31 0.01 
4000 – 4395 0.02 0.00 

Total general 6,167.46 100.00 

 

En la Figura 41 se muestran las longitudes de pendientes; con rangos perceptibles entre 

0 y 500 m, siendo los valores más altos para áreas con pendientes escarpadas y los más 

bajos para zonas de depositación, en lomeríos y áreas planas  
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Figura 41. Clasificación de longitud de la pendiente. 
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(f) Índice de posición topográfica (IPT) 

El IPT se usa para identificar los sistemas de topoformas, su cálculo se basa en el modelo 

elevación digital, a partir de la comparación de la elevación de una celda de interés con 

respecto al promedio de sus adyacentes (Weiss, 2001). Cuando el cálculo de IPT es de 

forma circular se emplea la siguiente ecuación: 

𝑰𝑷𝑻𝒇𝒆 = 𝑬𝒂
̅̅̅̅ − 𝑬𝒄       Ecuación 6. 

donde:  

IPTef : índice de posición topográfica para un radio de vecindad establecido.  

𝑬𝒂
̅̅̅̅  : elevación media del área, en m. 

Ec: elevación media de la celda, en m. 

Valores positivos indican regiones con mayores elevaciones, serranías, lomeríos, crestas 

(Figura 42). Los IPT negativos corresponden a áreas bajas como valles (Weiss, 2001). 

Valores cercanos a 0 representan zonas planas. 

 
Figura 42. IPT adaptado de Weiss, 2001 (Silveira y Silveira, 2014). 
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Este índice se calculó, para un radio de 30 m, con la extensión Land Facet Corridor 

Designer4 para ArcGIS 10 (Figura 43). La clasificación de los sistemas de topoformas, 

con base en los rangos de IPT y pendiente, se muestra en el Cuadro 13. 

 

 
Figura 43. Clasificación del relieve en función del IPT. 

 

 
Cuadro 13. Clasificación del relieve en función del IPT. 

 

 

 

 

 

 

 

 

                                                           
http://www.jennessent.com/arcgis/land_facets.htm 

Nombre IPT Pendientes 

Valles <=-1  

Pendientes bajas -1<TPI<=-0.5  

Pendientes suaves -0.5<TPI<=0.5 <=5° 

Pendientes medias -0.5<TPI<=0.5 >5° 

Pendientes altas 0.5<TPI<=1  

Picos y crestas >1  

http://www.jennessent.com/downloads/LandFacetCorridor_10.zip
http://www.jennessent.com/downloads/LandFacetCorridor_10.zip
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La clasificación del IPT se realizó de acuerdo con lo propuesto por Jenness et al., (2013), 

para distinguir los sistemas de topoformas. El área de estudio, de acuerdo con esta 

categorización, se encuentra un 46.77% en crestas, seguido por valles intermontanos 

(41.67%), lomeríos con pendientes suaves, lomeríos con pendientes moderadas y 

laderas escapadas (Cuadro 14). 

 
Cuadro 14. . Índice de posición topográfica. 

IPT Descripción Área (km2) Área (%) 

<-1 Valles intermontanos 2,569.72 41.67 

-1 a -0.5 Lomeríos o laderas suaves 535.42 8.68 

-0.5 a 0.5 
Lomeríos con laderas moderadas 
y pronunciadas 120.11 1.95 

0.5 a 1 
Laderas con pendientes 
escarpadas 57.42 0.93 

>1 Crestas 2,884.80 46.77 

Total general   6,167.46 100.00 

 

La distribución geográficas (Figura 44), según su IPT, muestran que los valores negativos 

corresponden a zonas con poca pendiente (valles intermontanos y lomeríos bajos), los 

valores cercanos a 0 a zonas planas, valores superiores a 1 corresponden a lomeríos 

medios a sierras con pendientes fuertes y escarpadas. 
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Figura 44. Clasificación del Índice de Posición Topográfica. 
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 Variables hidrológicas 

(a) Índice Topográfico de humedad (ITH) 

 

El índice de humedad fue diseñado para inferir, a través de datos topográficos, la 

distribución espacial de la humedad del suelo, la saturación superficial, la recarga de 

acuíferos, las áreas de descarga y el potencial de escorrentía (Kienzle, 2004). Su 

característica de concentrar la humedad lo hace útil en estudios de hidrología, 

agricultura, geomorfología y uso de suelo y vegetación.  

Barling et al. (1994) lo usa para caracterizar el régimen de humedad de los suelos, 

mientras que De Bruin et al. (1998) para ver la relación suelo-paisaje e identificar áreas 

de erosión y depositación. Este índice parte de la siguiente ecuación: 

 

𝑰𝑻𝑯 = 𝒍𝒏(
𝑨𝒔

𝐭𝐚𝐧 𝜷
)       Ecuación 7. 

 

donde:  

ITH: índice topográfico de humedad, en m2 m-1 ° 

As: área de drenaje específica de un punto, es decir, superficie que drena por 

unidad de longitud de la curva de nivel, en m2/m 

β: ángulo de la pendiente local, en °. 

 

Para obtener esta variable (Figura 45) se partió del modelo de elevación digital y su 

procesamiento para rellenar imperfecciones con la herramienta Fill; la cual se ubica en 

la caja de herramientas de ArcGis, Spatial Analyst Tools>Hydrology>Fill. Una vez 

corregido el MDE se obtuvo la dirección de flujo (Spatial Analyst Tools>Hydrology> Flow 

Direction), la acumulación de flujo (Spatial Analyst Tools>Hydrology> Flow 

Accumulation) y la pendiente en grados (3D Analyst Tools> Raster Surface>Slope> 

Degree). 
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Figura 45. Modelo para obtener el ITH. 

 

El área de drenaje específica (As), que representa la acumulación de flujo multiplicado 

por el tamaño del pixel del raster (15 m), se obtuvo con la calculadora de álgebra de 

mapas de ArcMap 10 (Spatial Analyst Tools>Map Algebra>Raster Calculator). 

 

El ángulo de la pendiente local (Tan β) se transformó de grados a radianes 

(pendiente*1.570796/90), con el uso de a la calculadora de ArcMap 10, y aplicando la 

siguiente condicionante: si la pendiente es mayor que 0, entonces calcula la tangente de 

esta, si no, colocar el valor de 0.001 (La instrucción en ArcGis Con(Pendiente_rad 

>0,Tan(Pendiente_rad),0.001). 

El Índice Topográfico de humedad se calculó, usando álgebra de mapas, con el logaritmo 

natural del cociente entre área de drenaje específico y ángulo de la pendiente. Para evitar 

valores nulos o negativos, al usar el logaritmo natural, primero se dividió As/TanB y se 

aplicó la siguiente condicionante: si el valor resultante es menor a igual a 1, entonces 

asígnale al cociente 1. 

Para el área de estudio resulto un índice de humedad que va de 0 a 24, este rango se 

clasificó cada 2 m2 m-1 ° resultando que el 39.61% se ubica de 2 a 4 m2 m-1 °, el 37.03%, 

de 0 a 2 m2 m-1 °, el 15.66% de 4 a 6 m2 m-1 °, el resto de las categorías tienen menos 

del 5% (Cuadro 15). 

 



 

83 

Cuadro 15. Índice topográfico de humedad. 

ITH Área (km2) Área (%) 

0 - 2 2,283.92 37.03 
2 - 4 2,442.74 39.61 
4 - 6 965.54 15.66 
6 - 8 265.85 4.31 
8 - 10 110.57 1.79 
10 - 12 57.56 0.93 
12 - 14 23.63 0.38 
14 - 16 10.47 0.17 

16 - 18 4.96 0.08 

18 - 20 1.75 0.03 

20 - 22 0.45 0.01 
22 - 24 0.03 0.00 

Total general 6,167.46 100.00 

 

En la Figura 46 se muestran la distribución de los rangos del índice topográfico de 

humedad. Los valores de mayor rango se ubican en los bajos fisiográficos y en donde se 

encuentran obstáculos como los caminos. 
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Figura 46. Distribución geográfica del Índice topográfico de humedad. 
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 Variables geológicas 

(a) Distancia a picos (estructuras volcánicas) 

Son las distancias que existen entre las crestas o picos y el resto de los sistemas de 

topoformas. La distancia entre picos condiciona el espesor de las cenizas volcánicas 

depositadas que, tras el intemperismo químico, contribuyen en la formación de algunos 

suelos de origen volcánico (Lizcano et al., 2006). 

 

Los picos se obtuvieron de la clasificación estandarizada del índice de posición 

topográfica, correspondiente a las áreas identificadas como crestas. Posteriormente, 

usando la herramienta de ArcGis Conversion Tools>From Raster>Raster To Polygon, se 

convirtieron estas áreas a formato vector. Enseguida, se generó un raster con la máxima 

altitud de las crestas con la herramienta Zonal Statistics, se asignó al tipo de estadísticas 

el máximo, y con álgebra de mapas se extrajeron las celdas con las máximas 

elevaciones. Posteriormente, estos pixeles5, con los puntos más altos, se pasaron a 

polígonos usando Conversion Tools>From Raster>RasterTo Polygon. Para obtener la 

posición de los picos, de este polígono, se le generó su centroide con Data Management 

Tools>Features>Feature to Point. Finalmente, a partir del vector con los picos resultante, 

se generó un raster de distancia euclideanas usando la herramienta Spatial Analyst 

Tools>Distance> Euclidean Distance. 

Las distancias de depositación de cenizas dependerá de la dirección de los vientos, para 

zona de estudio (Figura 47) las distancias a picos varían de 0 a 2509.5 m. Al clasificar 

las distancias, en rangos de 100 m, resulta que la distancia entre 300 y 400 m concentra 

el 16.74% del área, seguida por los rangos 400 - 500 m, 200 - 300 m, 500 - 600 m, 100 

- 200 m, 600 – 700 m, 700 – 800 m, el resto de los rangos se ubican con una superficie 

porcentual menor a 5 (Cuadro 16). 

 

 

 

                                                           
5 Pixel: Superficie homogénea más pequeña de las que componen una imagen, que se define por su brillo y color. 
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Cuadro 16. Rangos de distancia a picos (m). 

Distancia a Picos (m) Área (km2) Área (%) 

0 - 100 230.27 3.73 
100 - 200 645.93 10.47 
200 - 300 950.59 15.41 
300 - 400 1,032.60 16.74 
400 - 500 950.14 15.41 
500 - 600 745.61 12.09 
600 - 700 552.87 8.96 
700 - 800 374.65 6.07 
800 - 900 241.99 3.92 
900 - 1000 159.78 2.59 
1000 - 1200 166.98 2.71 
1200 - 1400 68.39 1.11 
1400 - 1600 27.71 0.45 
1600 - 1800 11.53 0.19 

1800 - 2000 5.30 0.09 

2000 - 2200 2.25 0.04 

2200 - 2400 0.76 0.01 
2400 - 2509.5 0.11 0.00 

Total general 6,167.47 100.00 

 

En la Figura 47 se observa que la porción noreste cuenta con una importante cantidad 

de picos y su concentración disminuye en las partes bajas del área de estudio. 
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Figura 47. Clasificación de Distancia a picos. 
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(b) Distancia a Fallas  

De las cartas E14-9 y E14-12 del Servicio Geológico Mexicano (SGM, 2000; SGM, 2001), 

se digitalizaron las fallas geológicas. Al analizar las fallas mayores se observó que la falla 

de Tamazulapam tiene gran influencia en la orografía regional, por lo que se seleccionó 

como base para obtener, a partir de esta, la distancia euclidiana. Para ello, se usó la 

herramienta Spatial Analyst Tools>Distance> Euclidean Distance. 

 

Para analizar esta variable se clasificaron las distancias a la falla de Tamazulapam en 

rangos de 2000 m, encontrándose distancias que van de 0 a 51,662 m. Los rangos con 

mayor frecuencia en el área de estudio son de 15,000 - 20,000, 20,000 - 25,000, 25,000 

- 30,000 y 30,000 - 35,000 (Cuadro 17). 

Cuadro 17. Distancias a la Falla Tamazulapam. 

Distancia a falla Tamazulapam (m) Área (km2) Área (%) 

0 - 2,000 379.37 6.15 
2,000 - 4,000 385.51 6.25 
4,000 - 6,000 380.21 6.16 
6,000 - 8,000 349.26 5.66 

8,000 - 10,000 311.51 5.05 
10,000 - 12,000 289.92 4.70 
12,000 - 15,000 439.81 7.13 
15,000 - 20,000 760.44 12.33 
20,000 - 25,000 788.80 12.79 
25,000 - 30,000 785.16 12.73 
30,000 - 35,000 627.94 10.18 
35,000 - 40,000 388.57 6.30 
40,000 - 45,000 187.81 3.05 
45,000 - 50,000 84.61 1.37 
50,000 - 51,662 8.55 0.14 

Total general 6,167.46 100.00 

 

La representación de las distancias se encuentra en la Figura 48, se observa que la 

interpolación de distancias parte del área central del área de estudio que es donde se 

ubica la falla Tamazulapam, por lo que las zonas más alejadas a la falla son la parte este 

y suroeste. 
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Figura 48. Clasificación de Distancia a fallas. 
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 Variables Cobertura vegetal 

Estas son aquellas que proporcionan protección al suelo para evitar que el suelo 

comience a erosionarse. 

 

(a) Índice de Vegetación de Diferencia Normalizada  

Dado que las imágenes seleccionadas se tomaron en diferentes fechas, estas corrigieron 

de manera independiente con base en su radianza y reflectancia, usando el criterio al 

Tope de la Atmosfera (TOA). La corrección topográfica no se realizó debido a que el 

modelo de elevación empleado tiene un tamaño de pixel de 15 m y no ayuda a quitar las 

sombras generadas por la topografía. 

 

El software utilizado para la corrección de las imágenes fue QGIS 2.16., para esto se 

extrajeron de los metadatos la siguiente información (Cuadro 18): B0= Banda azul, B1= 

Banda verde, B2= Banda roja, B3= Banda infrarroja cercana, DJ= Día juliano, Az= Angulo 

azimutal (°), d2= distancia cuadrada de la tierra al sol (UA), GAIN(p)=ganancias, 

BIAS(p)= Sesgo, E_0 (b)= Irradianza solar(W/m²/µm), θ_s= Angulo cenital (°)con la 

siguiente herramienta. 

Cuadro 18. Características de las imágenes de satélite. 

Imagen Fecha y 

DJ 

Banda GAIN

(𝒑) 

BIAS

(𝒑) 

Az Elevación 

solar 

𝜽𝒔 d2 𝑬𝟎(𝒃) 

IMG_SPOT7_MS_2015

11041640159_ORT_SP

OT7_20151105_195735

1b967w6g9u146_1_R1

C1 

4/Nov/2015 

310 

B0 

B1 

B2 

B3 

9.49 

10.075 

10.86 

15.388 

0 

0 

0 

0 

143.411 49.719 40.281 0.982 7.945 

6.026 

8.730 

10.210 

IMG_SPOT6_MS_2015

02161649077_ORT_SP

OT6_20160223_183414

1lnadm5tk9qzc_1_R1C1 

16/Feb/2015 

47 

B0 

B1 

B2 

B3 

8.26 

9.53 

10.44 

14 

0 

0 

0 

0 

135.407 

 

47.622 42.166 0.976 8.131 

3.511 

7.915 

9.092 

IMG_SPOT6_MS_2015

02161649314_ORT_SP

OT6_20160405_143510

16g76yr5aixv3_1_R1C1 

16/Feb/2015 

47 

B0 

B1 

B2 

B3 

8.26 

9.53 

10.44 

14 

0 

0 

0 

0 

134.853 47.686 42.105 0.976 8.131 

3.511 

7.915 

9.092 
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Imagen Fecha y 

DJ 

Banda GAIN

(𝒑) 

BIAS

(𝒑) 

Az Elevación 

solar 

𝜽𝒔 d2 𝑬𝟎(𝒃) 

IMG_SPOT6_MS_2015

02161649314_ORT_SP

OT6_20160405_143601

18jdkvcokzrzc_1_R1C1 

16/Feb/2015 

47 

B0 

B1 

B2 

B3 

8.26 

9.53 

10.44 

14 

0 

0 

0 

0 

134.427 48.119 41.668 0.976 8.131 

3.511 

7.915 

9.092 

IMG_SPOT7_MS_2015

01291638487_ORT_SP

OT7_20160223_183218

1dz7zq9glh04b_1_R1C1 

29/Enero/20

15 

29 

B0 

B1 

B2 

B3 

9.49 

10.48 

11.3 

16.93 

0 

0 

0 

0 

138.428 42.428 47.374 0.970 7.945 

6.026 

8.730 

10.210 

IMG_SPOT7_MS_2015

01291638487_ORT_SP

OT7_20160405_143300

13cjpm4cfgwl4_1_R1C1 

29/Ene/2015 

29 

B0 

B1 

B2 

B3 

9.49 

10.48 

11.3 

16.93 

0 

0 

0 

0 

138.074 42.941 46.860 0.970 7.945 

6.026 

8.730 

10.210 

B0= Banda azul, B1= Banda verde, B2= Banda roja, B3= Banda infrarroja cercana, DJ= Día juliano, Az= Angulo azimutal (°) d2= 

distancia cuadrada de la tierra al sol (UA), GAIN(𝑝)=ganancias, BIAS(𝑝)= Sesgo, 𝐸0(𝑏)= Irradianza solar (W/m²/µm), 𝜃𝑠= Angulo 

cenital (°) 

 

 Corrección Radiométrica 

Para convertir los valores digitales de las imágenes, aplicando el método de Radianza a 

TOA, se aplicó la Ecuación 8 en función de los coeficientes GAIN y BIAS. 

𝑳𝒃(𝒑) =
𝑫𝑪(𝒑)

𝑮𝑨𝑰𝑵 (𝒃)
+ 𝑩𝑰𝑨𝑺 (𝒃)       Ecuación 8. 

 

donde:  

𝐿𝑏(𝑝): radianza al tope de la atmosfera, en W sr-1·m-2 µm-1. 

DC(𝑝): números digitales. 

GAIN(𝑝): ganancias. 

BIAS(𝑝): sesgo. 

 

La corrección radiométrica se efectúo en el software Qgis 2.16.3 con la siguiente 

herramienta Raster>Raster Calculator> Se aplica la Ecuación 8, los comandos se ilustran 

en la Figura 49. 
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Figura 49. Comandos para el cálculo de radianza en Qgis. 

 

 Corrección Reflectancia 

Para la corrección reflectancia se empleó la Ecuación 9, para el método de TOA, en 

función de la radiación normalizada y la irradiación entrante. 

𝝆𝒃(𝒑) =
𝝅∙𝑳𝒃(𝒑)∙𝒅𝟐

𝑬𝟎(𝒃)∙𝐜𝐨𝐬 (𝜽𝒔)
       Ecuación 9. 

 

donde: 

𝝆𝑏(𝑝): reflectancia al tope de la atmosfera 

𝐿𝑏(𝑝): radianza al tope de la atmosfera, en W·sr−1·m−2·µm−1 

𝑑2: distancia de la tierra al sol al cuadrado, en unidades astronómicas. 

𝒅𝟐 = 𝟏 +
𝟎.𝟎𝟏𝟔𝟕𝟒∗𝐬𝐢𝐧(𝟐∙𝝅∗(𝑫𝑱−𝟗𝟑.𝟓))

𝟑𝟔𝟓
     Ecuación 10. 

DJ: día Juliano de la toma de la imagen 

𝐸0(𝑏): irradianza solar, en W m-2 µm-1 
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𝜃𝑠: angulo zenital, en radianes 

𝜽𝒔 = 𝟗𝟎°–  𝐀𝐧𝐠𝐮𝐥𝐨 𝐝𝐞 𝐞𝐥𝐞𝐯𝐚𝐜𝐢ó𝐧 𝐝𝐞𝐥 𝐬𝐨𝐥     Ecuación 12. 

 

La corrección de reflectancia se realizó en el software Qgis 2.16.3 con la siguiente 

herramienta Raster>Raster Calculator> Se aplica la Ecuación 9, los datos que alimentan 

a esta, los comandos se ilustran en la Figura 50. 

 

 
Figura 50. Comandos para el cálculo de reflectancia en Qgis. 

 

 Obtención del NDVI 

El NDVI (Índice de Vegetación de Diferencia Normalizada) fue creado por Rouse et al. 

(1974) y rango varía de -1 a 1. Este índice se calculó con la Ecuación 11. 

 

𝑵𝑫𝑽𝑰 =
𝑰𝑪−𝑹

𝑰𝑪+𝑹
       Ecuación 11. 
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donde: 

IC: banda del Infrarrojo cercano (banda 3) 

R: banda del Rojo (banda 2) 

 

Una vez calculado NDVI se transformó la imagen a un raster con resolución de 15 m. 

El área de estudio el NDVI se clasificó en cuatro rangos de -0.88 a 0.15, de 0.15 a 0.20, 

0.20 a 0.40 y de 0.40 a 0.66 (Cuadro 19). El primer rango representa sitios con poca o 

nula vegetación (suelo desnudo), el segundo representa suelos con vegetación baja 

como matorrales, pastizales xerófilos, el tercer rango corresponde a suelos cubiertos por 

vegetación mediana, y el último rango pertenece a suelos con vegetación alta. Más del 

70% de la zona se encuentra en la porción clasificada como suelo desnudo, seguido por 

áreas con vegetación mediana, vegetación baja y vegetación alta. 

 

Cuadro 19. Rangos del Índice de Vegetación Normalizada. 

Rangos de NDVI Descripción Área (km2) Área (%) 

-0.88 - 0.15 Suelo desnudo 4,847.19 78.59 

0.10 - 0.20 Vegetación baja 525.53 8.52 

0.20 - 0.40 Vegetación mediana 773.05 12.53 

0.4 - 0.66 Vegetación alta 21.69 0.35 

Total general  6,167.46 100.00 

 

La Figura 51 muestra la distribución geográfica de los valores de NDVI en el área de 

estudio. Se observa que la parte sur se concentran los sitios con mejor cobertura vegetal, 

mientras que la porción norte se tienen amplias zonas sin vegetación. 
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Figura 51. Clasificación del Índice de Vegetación de Diferencia Normalizada. 
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 Variable antropogénica 

Las actividades antrópicas como la agricultura, la ganadería, minería, construcción, son 

detonadoras de la degradación física del suelo. Así, la densidad de población en el medio 

rural es indicador indirecto de la presión sobre los recursos naturales y en particular sobre 

el recurso suelo. 

(a) Densidad de población 

Las densidades de población tienen una influencia importante en la degradación física 

causada por erosión hídrica al ir incrementado las fronteras agrícolas y pecuarias. La 

elevada densidad de población produce alta degradación física, química y biológica de 

los suelos.  

La densidad de población se obtuvo con la función de Kernel, la cual se fundamenta en 

una función de cuarto grado descrita por Silverman (1986). En esta función calcula una 

magnitud, por unidad de área, a partir de la población de cada punto para generar una 

superficie ajustada uniformemente a cada punto. Esta variable se obtuvo con el software 

ArcGis con los comandos Spatial Analyst Tools>Density> Kernel Density (Figura 52). 

 

 
Figura 52. Calculo de densidad de población con Kernel. 
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En el área de estudio el 51.33% de la superficie tiene una densidad de población de 0 a 

10 hab/km2, el 23.48% presenta una densidad media baja (10 a 25hab/km2), el 14.34% 

se considera como media (25 a 50hab/km2), el 8.38% es media alta (50 a 100hab/km2) y 

solo el 2.47% se considera como alta (Cuadro 20). 

 

Cuadro 20. Rangos de densidad de población. 

Densidad de población 
(hab/km2) 

Descripción Área (km2) Área (%) 

0 - 10 Baja 3,166.01 51.33 

10 - 25 Media baja 1,447.90 23.48 

25 - 50 Media 884.43 14.34 

50 - 100 Media alta 516.83 8.38 

>100 Alta 152.29 2.47 

Total general  6,167.46 100.00 

 

La distribución de los rangos de población, se muestra en la Figura 53, se observa que 

las altas densidades de población se concentran en los grandes centros de población y 

al norte es donde se tiene la menor concentración de población. 
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Figura 53. Clasificación de Densidad de Población. 
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 Escalamiento de variables 

Para realizar la corrida del Análisis de Componentes Principales, fue necesario escalar 

las variables a un rango de 0 – 250 con el propósito de homogenizar la información de 

cada variable (Figura 54).  

 
Figura 54. Model builder para escalar las variables. 

 

 Análisis de componentes principales 

Para las variables seleccionadas, través de ArcGis 10, se realizó el análisis de 

componentes principales (ACP). Como resultado del ACP se obtuvo la matriz de 

covarianza, la matriz de correlación de datos, los valores propios y el peso de la variable 

de acuerdo con la proporción que explica (Figura 55). 

 
Figura 55. Proceso de Análisis de Componentes Principales. 
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Las matrices, los valores propios y los porcentajes de variación se utilizaron para definir 

las variables que más influyen en la formación de cárcavas. 

 

 Clasificación supervisada para determinar la susceptibilidad a la 

formación de cárcavas 

Una vez seleccionados los componentes que concentran mayor cantidad de información 

se integró una imagen multibanda y sobre esta se definió, a partir de las áreas de 

entrenamiento, la posibilidad de cada pixel para generar cárcavas. 

 

 Áreas de entrenamiento 

A partir de los sitios visitados en campo y las imágenes de satélite de Google Earth Pro 

se digitalizaron los polígonos de las cárcavas observadas. Para las áreas delimitadas se 

extrajo información de las siguientes capas raster: curvatura vertical, curvatura 

horizontal, pendientes, TPI, ITH, NDVI, densidad de población, longitud de la pendiente, 

distancia a picos, distancia a fallas, altitud, densidad de corrientes, clima, orientación de 

la pendiente y porcentaje de cobertura vegetal. A estos datos se les realizó un análisis 

de frecuencias a fin de identificar las variables con tendencia clara y los rangos que mejor 

explican la presencia de cárcavas. Así, a los rangos seleccionados se asignó el valor de 

1, con el propósito de realizar un algebra de mapas booleana y retomar solo aquellos 

pixeles con una influencia definida. Es decir, se consideraron los pixeles que se 

encontraban dentro de los polígonos digitalizados. El raster resultante, con los rangos de 

mayor influencia, se convirtió a capa vector a fin de establecer estos pixeles como áreas 

de entrenamiento para fines de clasificación (Figura 56).  
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Figura 56. Áreas de entrenamiento. 

 

Se realizó un análisis de frecuencias de las siguientes capas curvatura de perfil, 

curvatura horizontal, pendientes, IPT, ITH, NDVI, densidad de población, longitud de 

pendiente, distancia a picos, distancia a fallas, altitud, densidad de corrientes, climas, 

orientación, y porcentaje de cobertura. 

 

 Creación de firmas ambientales6 

Para la creación de las firmas ambientales se usó la herramienta Spatial Analyst 

Tools>Multivariate> Create Signatures de Arc Gis. Este procedimiento genera, en un 

archivo gsg, los valores estadísticos (matrices de medias y covarianzas) de las áreas de 

entrenamiento correspondientes a la imagen multicapa.  

 

                                                           
6 Firmas ambientales: Valores de luz reflejada por las variables ambientales o los matices de estas. 
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 Clasificación supervisada 

La clasificación se realizó con el método de máxima probabilidad o máxima verosimilitud. 

Este método asume que las muestras se ajustan a una distribución normal, lo que 

permite, a partir de las firmas ambientales (medias, varianzas-covarianzas), determinar 

la probabilidad de un pixel para desarrollar una cárcava.  

 Puntos de inspección 

De acuerdo Rossiter et al. (2002) la intensidad de levantamiento de suelos se basa en la 

escala en que se publica, la intensidad de inspección y el objetivo del estudio. Para una 

escala de trabajo 1:50 000, considerando una intensidad de inspección medio 

(semidetallado) y un objetivo con fines de evaluar las tierras (planear), la densidad es de 

recomendada es de 1 a 5 sitios por km2. Con el rango anterior se propuso 1.1 puntos de 

inspección por km2. 

 
Figura 57. Procedimiento para crear puntos al azar. 

 

De ese modo, en ArcGis se generaron 289 puntos al azar sobre la cobertura clasificada 

como cárcavas. Los comandos para crear los puntos fue Data Management 

Tools>Feature class> Create Random Points (Figura 57). Para cada uno de los puntos 
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de inspección se marcaron 3 radios de curvatura: 50, 100 y 150m. El radio máximo se 

estableció de tal manera que el área a evaluar, por punto, cubriera aproximadamente 7 

ha. Para verificar los resultados se realizó sobre imágenes de Google Earth Pro, se midió 

para cada radio de curvatura el porcentaje de cobertura con cárcavas. En la Figura 58 

se muestra, a nivel de ejemplo, los radios evaluados y sus correspondientes porcentajes 

de afectación por cárcavas. 

 
Figura 58. Ejemplos de inspección en Google earth. 

 

 Confiabilidad de la clasificación 

Para medir la confiabilidad de la capa de cárcavas, se contabilizó la cantidad de radios 

de curvatura con un porcentaje de afectación superior al 50% y se analizó con cual radio 

se obtienen los mejores resultados. 
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6. RESULTADOS 

6.1. Variables seleccionadas 

 Pendiente topográfica 

Al analizar la distribución de la pendiente, sobre los polígonos utilizados como semillas 

para clasificación supervisada, se observa las cárcavas se presentan con mayor 

frecuencia en el rango 2.5 a 6.5% (29.16%) y en el intervalo 7.5 a 22.5% (51.57%) (Figura 

59). Las pendiente más bajas se asocian a atrincheramientos en las inmediaciones de 

valles intermontanos y las más altas a cárcavas ubicadas en lomeríos compuestos de 

materiales residuales. Aun cuando en pendientes superiores existe mayor riesgo de 

erosión, es menos común su presencia ya que generalmente estos terrenos son someros 

y cubiertos con vegetación. 

 
Figura 59. Distribución de las cárcavas en función de la pendiente del terreno (áreas de 

entrenamiento). 

 

Para la zona centro de México se encontró que las mayoría de las cárcavas se 

desarrollan en rangos que va n de 0 a 18% ubicándose la mayor parte entre 2 y 8% 

(Palacios, 1990), en el área de estudio se ubican en  pendientes 1 a 77%, pero la mayoría 

están en rangos de 2 a 20%. Los riegos a erosión severa en pendientes mayores al 20%  
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son altos, sin embargo, en la mayoría de los casos existe la protección de la vegetación 

que evita la pérdida de suelo. 

 Curvatura vertical o de perfil (CV) 

Según Klingseisen et al. (2008), la velocidad de la corriente varía a largo de una ladera 

de acuerdo con su curvatura vertical. Al analizar las cárcavas, dentro de los polígonos 

de entrenamiento, las cárcavas en el área de estudio se presentan en curvaturas 

verticales entre -3.4 y 3.45; principalmente en el rango -0.75 y -0.05 (27.15%) y 0.05 y 

1.05 (68.49%) (¡Error! No se encuentra el origen de la referencia.). El rango negativo 

ndica que la velocidad de la corriente se incrementa conforme desciende, lo que genera 

flujos con mayor potencial para causar erosión en materiales residuales consolidados en 

los lechos de las cárcavas. Por otra parte, los valores positivos se relacionan con 

cárcavas localizadas en zonas donde la sedimentación es el proceso dominante, es 

decir, estas se localizan en las inmediaciones de los valles aluviales. 

 

Figura 60. Distribución de las cárcavas en función de la curvatura vertical (áreas de 
entrenamiento). 

La mayor parte de las cárcavas se ubicaron en curvaturas cóncavas (valores positivos) 

que representa flujo acelerado que provoca el desprendimiento del suelo provocando 

una erosión acelerada. 
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 Curvatura Horizontal o plana (CH) 

La curvatura horizontal indica si el escurrimiento es convergente o divergente. Con base 

en la Figura 61, las cárcavas en la zona se localizan principalmente entre -4.75 y 5.65 

(adim.) y con mayor frecuencia en los rangos -1.75 a -0.45 (32.7%) y entre 0.05 y 1.75 

(64.5%). En general, el rango negativo corresponde a flujos convergentes asociados a 

topografías cercanas a valles donde se generan corrientes con mayor acumulación de 

caudal y potencial erosivo, por otro lado, las curvaturas positivas se vinculan a flujos 

divergentes, como ocurre en topografías cónicas (volcánicas) con pendientes más 

pronunciadas. 

 
Figura 61. Distribución de las cárcavas en función de la curvatura horizontal (áreas de 

entrenamiento). 

Las cárcavas con curvatura horizontales superiores a 0 son sitios donde el flujo converge 

formando parte de una corriente acelerada que genera flujos concentrados aumentando 

el riesgo a erosión. 

 

 Longitud de la pendiente 

La longitud de la pendiente es un factor topográfico que describe la longitud de la ladera, 

su importancia en la erosión hídrica de suelos radica en que es la distancia horizontal del 

punto donde comienza el escurrimiento hasta donde disminuye el grado de la pendiente 

al punto que se da la sedimentación (Oñate-Valdivieso, 2004). Conforme incrementa la 

longitud de la pendiente, aumenta la velocidad de escorrentía y la capacidad de arrastre 
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de sedimentos, en laderas con mayor longitud es más frecuente la aparición de canalillos 

que con el paso del tiempo se convierten en cárcavas. 

Las cárcava en el área de estudio se presentan en laderas con longitudes entre 0 y 1300 

m, pero principalmente en longitudes entre 10 y 30 m (22.18%) y en longitudes de 35-

110m (33.52%). En general se observa que el rango más bajo corresponde a áreas de 

depósitos aluviales y mientras las longitudes mayores a terrenos de ladera baja. (Figura 

62). 

 
Figura 62. Distribución de las cárcavas en función de la longitud de la pendiente (áreas de 

entrenamiento). 

 

 

 Índice de posición topográfica 

Dentro de los límites de los polígonos de entrenamiento se observa la mayoría de las 

cárcavas se ubican en TPI>1 y TPI<1, es decir, en crestas (49.69%) y en valles 

intermontanos (42.22%), respectivamente. Esto indica que las cárcavas ocurren 

principalmente en las cretas con presencia de materiales residuales de toba volcánica y 

en las inmediaciones de los valles intermontanos donde los escurrimientos producen, en 

los materiales aluviales depositados con anterioridad, atrincheramientos. (Figura 63). 
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Figura 63. Distribución de las cárcavas en función del Índice de posición topográfica (áreas de 

entrenamiento). 

 

 

 Índice topográfico de humedad 

El ITH es utilizado para identificar sitios donde se concentra la humedad en el suelo. Su 

valoración permite, por ejemplo, en correlacionar el deslizamiento en taludes con la 

humedad del suelo. Al analizar el índice topográfico de humedad, en los límites de los 

polígonos de entrenamiento, se encontró que las cárcavas se distribuyen entre 0 y 14 m2 

m-1 °; pero ocurren principalmente entre 0.0 y 2.0 m2 m-1 ° (42.43%), que se relacionan a 

acumulaciones medias de humedad, de pendiente moderada y materiales residuales de 

toba volcánica; también estas ocurren entre 2.0 y 7.0 m2 m-1 ° (56.64%) que 

corresponden a áreas con las mayores acumulaciones de agua, pendientes bajas y 

materiales aluviales, características que se conjugan en las inmediaciones de los valles 

intermontanos. (Figura 64). 
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Figura 64. Distribución de las cárcavas en función del Índice Topográfico de humedad (áreas de 

entrenamiento). 

Como este índice representa la distribución de la humedad en el suelo y depende la 

geomorfología, los valores superiores se ubican en zonas planas y los más bajos se 

ubican en laderas pronunciadas y lomeríos, la mayoría de las cárcavas en el área de 

estudio se ubican en geoformas diferentes a zonas planas por lo que las escorrentías 

tienden a acelerarse y transportar importantes cantidades de sedimentos. 

 

 Distancia a picos 

La distancia a picos topográficos, identificados muchos de ellos como volcanes, es una 

variable importante ya que de esta dependen los sitios donde se depositaron las cenizas 

volcánicas y tobas, las cuales son materiales con alta susceptibilidad a la erosión.  

Al analizar el histograma de frecuencias de distancia a picos, para los polígonos de 

entrenamiento, en la Figura 65 las cárcavas se distribuyen a una distancia, a los picos 

topográficos más cercanos, de 0 a 1 300 m, pero se concentran a distancias entre 100 y 

400 m (46.91%) y entre 500 y 900 m (29.66%). Las cárcavas más cercanas a picos se 

inscriben a materiales volcánicos residuales, que circundan antiguas estructuras 

volcánicas, y las más alejadas a depósitos aluviales perimetrales a los valles 

intermontanos. 
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Figura 65. Distribución de las cárcavas en función de la distancia a picos (áreas de 

entrenamiento). 

 

 

 Distancia a fallas 

Según los polígonos de entrenamiento, la zona con cárcavas se ubican a una distancia 

entre 0 y 12 000 m de la falla Tamazulapam, la mayor frecuencia ocurre de 0 a 4 000 m 

(49.87%), seguido del rango 4 000 a 10 000 m (45.87%). Así, las cárcavas más cercanas 

a la falla están asociadas a una mayor actividad volcánica y las más alejadas a la 

formación de valles aluviales. En este sentido, Irigaray y Chacón (2002) mencionan que 

la distancia a fallas es una variable que contribuye a la inestabilidad de las masas de 

suelo. (Figura 66). 
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Figura 66. Distribución de las cárcavas en función de la distancia a fallas (áreas de 

entrenamiento). 

 

 Índice de Vegetación de Diferencia Normalizada 

El índice de vegetación de diferencia normaliza es una variable importante en la 

formación de cárcavas por el aporte de datos que proporciona sobre la existencia de 

vegetación en un determinado lugar. Los valores de NDVI bajos representan sitios con 

escasa cobertura vegetal, dato importante para identificar sitios con probables problemas 

de erosión. Las cárcavas en el área de estudio presentan valores de NDVI entre -0.54 y 

0.29 concentrándose estas en el rango entre -0.16 y 0.2 (99.02%), es decir se concentran 

en suelo desnudos y vegetación baja (López-Perez et al., 2015). Esto concuerda con los 

resultados de Alatorre y Bequería (2009), quien menciona que las cárcavas se 

establecen principalmente en zonas marginales donde es difícil que se establezca la 

vegetación en pendientes superiores al 15%. (Figura 67). 

 
Figura 67. Distribución de las cárcavas en función del Índice de Vegetación de Diferencia 

Normalizada. (Áreas de entrenamiento). 
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 Densidad de Población 

Para los polígonos de las áreas de entrenamiento, en el área analizada se encontró que 

las cárcavas se ubican en sitios con densidades entre 0 a 170 hab km-2, distribuidas 

principalmente los rangos 5 - 30 hab km-2 (60.91%) y 30 - 70 hab km-2 (31.40%). Las 

densidades bajas de población corresponden a cárcavas localizadas en sitios de difícil 

acceso y escaso potencial agrícola mientras que las cárcavas localizadas en lugares con 

densidades medias corresponden a entornos con mayor actividad agrícola, como ocurre 

en las inmediaciones de los valles aluviales. (Figura 68). Esto indica que las poblaciones 

grandes realizan sus actividades agropecuarias principalmente en áreas planas y a 

kilómetros de los centros de población, lo que explica la menor cantidad de cárcavas en 

áreas cercanas a los centros de población. 

 

 
Figura 68. Histograma de Densidad de Población. 

 

 

 

 

 

 



 

113 

6.2. Análisis de componentes principales 

El resultado del análisis de componentes principales fue una imagen multicapa (10 

capas), en la capa 1 recopila la mayor variabilidad, la cual disminuye sucesivamente con 

el resto de las capas. Otro producto del ACP son las matrices estadísticas donde se 

presenta la covarianza, correlación, vectores propios y autovalores de las variables en 

cada componente principal; habiendo tantos componentes principales como variables. 

En la matriz de covarianzas, resultado del ACP para las diez variables analizadas, se 

observa en la diagonal (Cuadro 21), que la distancia a la falla Tamazulapam tiene mayor 

la variabilidad (55.8%), seguida de la distancia a picos (12.3), índice topográfico de 

humedad (11.1%), NDVI (9.0%), pendiente (5.0%), índice de posición topográfica (2.8%), 

densidad de población (1.5%), longitud de la pendiente (1.3%), curvatura vertical (0.6%) 

y curvatura plana (0.5). Esto implica que las variables DF, DP, ITH, NDVI explica el 88.2% 

de la variabilidad de la información, es decir, son las que más aportarán a los resultados. 

Cuadro 21. Matriz de covarianzas del ACP. 

Variable CH CV D DF DP ITH LP NDVI PEN ITP 

CH (Adim.) 15.14 11.87 -0.01 0.00 -2.79 -23.19 -6.12 3.02 -5.24 12.52 

CV (Adim.) 11.87 17.68 0.01 -0.38 -0.99 -26.81 -8.00 2.28 -1.48 8.96 

D (hab km-2) -0.01 0.01 42.86 15.45 -1.11 5.62 -1.34 2.51 -5.07 -0.37 

DF (m) 0.00 -0.38 15.45 1590.44 -10.34 -17.74 1.70 44.64 27.83 0.60 

DP (m) -2.79 -0.99 -1.11 -10.34 349.72 32.37 14.53 -22.28 -13.56 -40.53 

ITH (m2 m-1 °) -23.19 -26.81 5.62 -17.74 32.37 317.26 56.79 -9.97 -20.56 -45.25 

LP (m) -6.12 -8.00 -1.34 1.70 14.53 56.79 37.04 -1.64 1.22 -14.97 

NDVI 3.02 2.28 2.51 44.64 -22.28 -9.97 -1.64 256.60 -0.10 9.51 

PEN (%) -5.24 -1.48 -5.07 27.83 -13.56 -20.56 1.22 -0.10 143.48 -13.82 

IPT (Adim.) 12.52 8.96 -0.37 0.60 -40.53 -45.25 -14.97 9.51 -13.82 79.31 

 

Al observar la matriz de correlaciones (Cuadro 22) destaca que la curvatura vertical y 

horizontal presenta alta correlación entre ellas (0.73) por lo que se puede prescindir de 

una de las dos sin alterar significativamente los resultados. Entre longitud de pendiente 

e índice topográfico de humedad se tiene una correlación intermedia (0.52), debido a que 

el índice de humedad considera la forma y longitud de pendiente para modelar la 

distribución de la humedad en el terreno. 
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Cuadro 22. Matriz de correlaciones del ACP. 

Variable CH CV D DF DP ITH LP NDVI PEN IPT 

CH (Adim.) 1.0 0.73 0.00 0.00 -0.04 -0.33 -0.26 0.05 -0.11 0.36 

CV (Adim.) 0.73 1.0 0.00 0.00 -0.01 -0.36 -0.31 0.03 -0.03 0.24 

D (hab km-2) 0.00 0.00 1.0 0.06 -0.01 0.05 -0.03 0.02 -0.06 -0.01 

DF (m) 0.00 0.00 0.06 1.0 -0.01 -0.02 0.01 0.07 0.06 0.00 

DP (m) -0.04 -0.01 -0.01 -0.01 1.0 0.10 0.13 -0.07 -0.06 -0.24 

ITH (m2 m-1 °) -0.33 -0.36 0.05 -0.02 0.10 1.0 0.52 -0.03 -0.10 -0.29 

LP (m) -0.26 -0.31 -0.03 0.01 0.13 0.52 1.0 -0.02 0.02 -0.28 

NDVI 0.05 0.03 0.02 0.07 -0.07 -0.03 -0.02 1.0 0.00 0.07 

PEN (%) -0.11 -0.03 -0.06 0.06 -0.06 -0.10 0.02 0.00 1.0 -0.13 

IPT (Adim.) 0.36 0.24 -0.01 0.00 -0.24 -0.29 -0.28 0.07 -0.13 1.00 

 

Los vectores propios, generados por el ACP (Cuadro 23), muestra que el componente 

uno (CP1) la variable que tiene más peso es la distancia a la falla de Tamazulapam, en 

CP2 y CP3 la distancia a picos y el índice topográfico de humedad, en CP4 el NDVI, en 

CP5 la pendiente, en CP6 el índice de posición topográfica, en CP7 la densidad de 

población, en CP8 la longitud de la pendiente, en CP9 la curvatura vertical, plana y 

longitud de la pendiente y en CP10 la curvatura plana y la curvatura vertical. 

Cuadro 23. Matriz de vectores propios del ACP. 

Variable 
Componentes Principales (CP) 

1 2 3 4 5 6 7 8 9 10 

CH (Adim.) 0.00 0.05 0.06 0.01 0.07 0.14 0.02 0.23 0.59 -0.75 

CV (Adim.) 0.00 0.05 0.07 0.01 0.04 0.09 0.03 0.35 0.66 0.65 

D (hab km-2) 0.01 -0.01 -0.02 0.01 0.05 -0.03 0.99 -0.13 0.03 0.00 

DF (m) 1.00 -0.02 0.00 -0.03 0.02 0.00 -0.01 0.00 0.00 0.00 

DP (m) -0.01 -0.74 0.62 0.20 -0.01 0.12 0.01 0.00 -0.03 0.00 

ITH (m2 m-1 °) -0.01 -0.59 -0.75 0.02 -0.02 0.20 0.01 0.19 0.00 0.00 

LP (m) 0.00 -0.13 -0.13 0.01 -0.06 -0.06 -0.13 -0.86 0.45 0.05 

NDVI 0.03 0.17 -0.11 0.98 -0.04 -0.02 -0.01 0.00 -0.01 0.00 

PEN (%) 0.02 0.07 0.04 -0.04 -0.96 0.24 0.06 0.03 0.01 -0.02 

IPT (Adim.) 0.00 0.19 0.05 0.00 0.24 0.92 0.00 -0.18 -0.12 0.05 

 

Los autovalores para cada componente principal, generados por el ACP, proporcionan 

el porcentaje de variación que explica cada uno de ello. Estos valores son útiles para 

seleccionar el número de componentes principales con la mayor concentración de datos 
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originales (Cuadro 24). La manera más común de seleccionar el número de componentes 

idóneos es a través de una gráfica de densidad se observe el porcentaje acumulado de 

autovalores por componente principal (Figura 69). En este caso, para determinar la 

probabilidad de presencia de cárcavas, se seleccionaron los primeros seis componentes 

principales que explican el 96.7% de la información contenida en las diez variables 

analizadas. 

 
Cuadro 24. Matriz de autovalores y porcentaje de variación explicada del ACP. 

VARIABLE 
COMPONENTES PRINCIPALES 

1 2 3 4 5 6 7 8 9 10 

Autovalores 1593.00 394.95 307.25 250.44 146.67 63.79 42.61 25.65 20.96 4.21 

% 55.9 13.9 10.8 8.8 5.1 2.2 1.5 0.9 0.7 0.1 

% ACUM 55.9 69.8 80.5 89.3 94.5 96.7 98.2 99.1 99.9 100.0 

 

El número de componentes se elige cuando se presenta un cambio de pendiente 

importante, en este caso sucede en el segundo componente (variabilidad explicativa del 

69.8%). Sin embargo, no se seleccionaron estos ya que la variabilidad explicativa es 

intermedia, por tal motivo se optó por considerar el siguiente cambio de pendiente (punto 

6) donde la curva se estabiliza. Así, para el CP=6 se tiene una variabilidad acumulada 

del 96.7%. 

 
Figura 69. Grafica de densidad de los componentes principales. 
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 Descripción de los Componentes principales seleccionados 

A continuación, se detallan los 6 componentes principales que resultaron de la gráfica de 

densidad.  

 Componente 1. Está influenciado en mayor medida por la distancia a fallas, 

seguido por NDVI, pendiente del terreno, densidad de población, distancia a picos 

y índice topográfico de humedad; estos tres últimos aun cuando su signo es 

negativo concentran la misma variabilidad. Este componente básicamente 

concentra información geológica. 

 Componente 2. Las variables con mayor influencia en este componente son 

distancia a picos, índice topográfico de humedad, índice de posición topográfica y 

NDVI. Al considerar los pesos totales agrupando las variables, el 37.6% está 

dominado por la geología, seguida por la hidrología (29.2%), por la topografía 

(24.3%), la cubierta vegetal (8.4%) y las antropogénica (0.5%). Tomando en 

cuenta los datos anteriores este componente concentra información 

geohidrológica. 

 Componente 3. En este caso las variables dominantes son el índice topográfico 

de humedad y la distancia a picos. Agrupando las variables, la parte hidrológica 

tiene el 40.5% de peso, el geológico recopila el 33.5%, el topográfico el 18.9%, la 

cobertura vegetal el 6% y la parte antropogénica el 1.1%. Con estas estadísticas 

el componente concentra información hidrogeológica. 

 Componente 4. Las variables que más resaltan en este componente son NDVI y 

distancia a picos. Al analizar por grupos, el 74.8% corresponde a la cobertura 

vegetal, el 17.6% a la geología, el 5.3% a la topografía, el 1.5% son hidrológicas 

y el 0.8% antropogénica. Con las características anteriores se considera que este 

componente concentra información de cubierta vegetal. 

 Componente 5. Este rescata una importante cantidad de información de la 

variable pendiente (%), seguido del índice de posición topográfica. Al agrupar las 

variables es clara la dominancia de topográfica ya que tiene un peso del 90.7%, 
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seguido del antropogénico, cubierta vegetal, geológico e hidrológico. Por cual se 

afirma que este componente concentra principalmente datos topográficos. 

 Componente 6. Las variables de las que recopila mayor información este 

componente son Índice de posición topográfica, pendiente y curvatura plana. Así 

el componente topográfico domina con un peso del 79.7%, seguido por el 

hidrológico (11%), el geológico (6.6%), el antropogénico (1.6%) y finalmente la 

cobertura vegetal (1.1%), por lo tanto, este grupo concentra información 

topohidrológica. 

 

 Cobertura raster resultado del ACP 

Con cada componente se realizó una composición de las 6 capas a una sola imagen 

(Figura 71) para estimar, con base en los sitios de entrenamiento, la probabilidad de 

ocurrencia de cárcavas. Aparentemente la imagen con 10 capas (Figura 70) y la 

compuesta por los 6 componentes no muestran diferencias significativas ya que esta 

última concentra el 96.75 de la información original. 

 
Figura 70. Imagen del ACP con 10 capas. 

 

 
Figura 71. Imagen del ACP con 6 bandas. 
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6.3. Probabilidad de existencia de cárcavas 

Al clasificar la imagen multicapa, con los seis componentes principales seleccionados, 

se encontró que el 90.17% del área de estudio no presenta cárcavas, mientras que el 

9.83% de la superficie total (606.54 km2) tiene una probabilidad de existencia de cárcavas 

mayor 0.5%. Asimismo, el 4.23% de la superficie (261.11 km2) tiene una probabilidad 

superior de 50% de que existan esta forma de erosión (Figura 72 y Cuadro 25).  

 

 

 

 

 

 

 

Cuadro 25. Probabilidad de existencia de cárcavas. 

Probabilidad 
de existencia 

Área (km2) Área (%) 

0 5,560.92 90.17 

0.5 5.68 0.09 

1 5.07 0.08 

2.5 18.75 0.30 

5 39.16 0.64 

10 90.01 1.46 

25 186.76 3.03 

50 146.95 2.38 

75 75.7 1.23 

90 27.56 0.45 

95 6.4 0.10 

97.5 2.6 0.04 

99 1.23 0.02 

99.5 0.35 0.01 

100 0.32 0.01 

Total general 6,167.46 100.00 
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En el Cuadro 26 se resumen los rangos donde se ubican las cárcavas con respecto a las 

variables de mayor influencia en el área de estudio. 

 

Cuadro 26. Variables más importantes en la formación de cárcavas. 

Variable Rango de distribución 
Observaciones para posibilidad de mayor 

50% de formación de cárcavas. 

Distancia a falla 
Tamazulapam 

0 a 25988m De 670.9 a 23010.9 m de la fallas 
Tamazulapam. 

Distancia a picos 15 y 1680 m Rangos de 15 a 1248m de los picos 

índice topográfico 
de humedad 

0 a 11.89 En promedio entre 0-7 de ITH 

Índice de posición 
topográfico 

(Topoformas) 

lomeríos con laderas 
moderadas a 
pronunciadas 

Los sistemas de topoformas con más 
fragilidad va de lomeríos suaves a lomeríos 

con laderas moderadas y pronunciadas 

NDVI 

0.13 a 0.25 (suelos 
desnudos a vegetación 

baja y mediana) 

En clases de -0.11 a 0.20 (terrenos desnudos 
y vegetación baja). 

Pendientes 

0 a 27% De 0-22%, de aquí que los terrenos más 
susceptibles son los de pendientes fuertes, 

moderadas y suave 

Densidad de 
población 

media baja (10 a 
25100hab km-2) a media 
alta (50 a 100hab km-2) 

0.04 

 

La distribución geográfica de las probabilidades de existencia de cárcavas se ubica en la 

Figura 72. 
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Figura 72. Probabilidad de existencia de cárcavas. 

 

6.4. Validación de resultados 

Para la validación de resultados se consideraron los sitios con una probabilidad de 

existencia superior al 50%, la superficie total con esta probabilidad fue de 261.11 km2, 

de acuerdo con la metodología para asignación de puntos de verificación para la escala 

1:50 000 le corresponden de 1 a 5, para este caso se adoptó 1.1 por km2, por lo tanto, 

se lanzaron 289 puntos de verificación al azar, a cada punto se le hizo 3 buffer con 

diferentes radios, con un radio de 50, 100 y 150 m. Los puntos de verificación se 

realizaron en imágenes de google earth, estos se analizaron desde el punto de vista  de 

existencia o no existencia y el porcentaje de afectación. 

 

Las coordenadas de los puntos analizados, al azar, se indican el ¡Error! No se 

ncuentra el origen de la referencia., así como el porcentaje de afectación observado 

por radio de curvatura (50, 100 y 150 m). Al contabilizar la presencia o ausencia de 
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cárcavas, en 289 puntos de verificación, con una probabilidad de existencia superior al 

50%, se encontraron cárcavas en 278 puntos lo que produce una confiabilidad global del 

mapa generado del 96.2%. Al considerar el 20% de afectación en los buffer se 

identificaron 251 sitios con cárcavas y 38 sin ellas por lo que la certeza de predicción 

disminuyó a 86.9%. 

 

La siguiente ¡Error! No se encuentra el origen de la referencia. ilustra el 

omportamiento que tiene el porcentaje de cobertura en cada uno de los buffer con 

respecto al número de estos con afectación, la tendencia es clara, entre mayor sea el 

radio de los buffer la predicción de sitios con cárcavas disminuye, tomando en cuenta un 

porcentaje de afectación de 30-40%, el buffer de 50m predice una confiabilidad de 

83.4%, el de 100m de 81.7% y de 150 es de 77.9%. Entre menor es el buffer de 

verificación la confiabilidad de predicción incrementa. 

 
Figura 73. Porcentaje de cobertura de cárcavas en los puntos de verificación. 



 

122 

7. CONCLUSIONES 

Las áreas susceptibles a formación de cárcavas se pueden ubicar con las variables 

ambientales, geológicas, topográficas, hidrológicas, de cobertura vegetal y 

antropogénicas. 

En el área de estudio las cárcavas se presentan en suelos residuales de toba al pie de 

monte de antiguos aparatos volcánicos y en depósitos aluviales que circundan los valles 

intermontanos. 

A nivel regional la distancia a la falla de Tamazulapam  y la presencia de aparatos 

volcánicos condicionan la formación de cárcavas, seguido de factores geomorfológicos 

que controlan procesos de erosión y sedimentación como se infiere a través del índice 

topográfico de humedad, pendiente del terreno, NDVI, índice de posición topográfica.  

La formación de cárcavas es un proceso natural que depende de los tipos de materiales 

de formación geológica y de la ubicación geográfica de cada sitio. 

Las variables ambientales son una alternativa para identificar las áreas susceptibles con 

problemas de erosión severa (sitios con cárcavas), estas proporcionan información 

precisa de los sitios a analizar además que se obtiene de manera rápida y con bajos 

costos en comparación con las imágenes satelitales de alta resolución. 

El análisis multivariado es una herramienta útil para determinar las variables que influyen 

en procesos ambientales como la formación de cárcavas, en particular el Análisis de 

componentes principales 

El método de clasificación supervisada, usando ACP, permite identificar áreas con 

presencia de cárcavas con una precisión aceptable y es útil para determinar el potencial 

de un sitio para desarrollar este tipo de erosión. 
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8. RECOMENDACIONES 

Uno de los problemas a los que se enfrentó esta investigación fue la insuficiencia de 

fuentes de información a una escala superior a 1:50 000, por lo que es recomendable 

trabajar con áreas pequeñas para poder generar información a detalle y no depender de 

otras fuentes. 

Para mayor precisión en las variables topográficas lo ideal sería trabajar con modelos de 

elevación de mejor resolución, información lidar o vuelos con drones que proporcionen 

mayor detalle las características del terreno. 

Los resultados de esta investigación son una herramienta para planear futuros trabajos 

de manera particular, para estos es necesario realizar determinaciones en campo que 

proporcionen el comportamiento de los materiales y la susceptibilidad de estos ante la 

interacción de las variables ambientales que detonan la erosión en cárcavas. 
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10. ANEXOS 

Anexo 1. Puntos de verificación en google earth. 

 

Cuadro 27. Punto de verificación de cárcavas. 

Punto de 
Verificación 

Coordenadas UTM Zona 14 

 Porcentaje de  
afectación del Buffer 

  
  

Latitud Longitud 50m 100m 150m 

1 654,276.282234 1,907,033.690790 100 100 100 

2 679,473.982077 1,907,688.213950 90 65 60 

3 670,409.480084 1,951,772.135110 100 100 90 

4 654,324.502587 1,906,685.754180 90 70 40 

5 656,278.429785 1,905,965.300030 90 65 50 

6 655,469.570472 1,910,497.465590 90 70 40 

7 673,086.194717 1,913,052.681680 90 75 60 

8 674,682.080915 1,933,101.916300 80 60 60 

9 672,731.490170 1,922,496.866080 80 90 90 

10 653,447.783529 1,913,969.438130 20 30 40 

11 656,658.097458 1,909,105.920800 80 80 70 

12 678,175.555956 1,917,502.663440 50 30 30 

13 677,668.681550 1,915,561.005380 100 90 70 

14 675,611.939116 1,933,142.238260 100 100 95 

15 651,107.831332 1,918,189.336040 70 70 70 

16 654,482.822657 1,907,748.337300 100 95 98 

17 675,770.713569 1,932,032.450340 70 60 50 

18 680,126.217361 1,909,471.610880 5 10 20 

19 651,853.154875 1,929,278.053180 90 70 65 

20 659,677.001881 1,893,098.434410 90 70 50 

21 675,734.817077 1,903,380.041420 70 30 30 

22 670,450.928855 1,906,699.713790 30 30 30 

23 654,054.043324 1,906,819.032320 100 95 95 

24 681,152.325893 1,907,862.783810 80 50 40 

25 655,775.334798 1,904,694.361980 100 80 70 

26 678,590.351289 1,909,260.899740 10 5 5 

27 676,149.359394 1,919,798.635160 70 50 50 

28 650,406.782922 1,921,753.469310 95 90 80 

29 660,824.190484 1,966,495.349960 95 80 60 

30 656,964.025480 1,909,219.589080 100 90 60 

31 656,365.488469 1,904,277.186930 100 100 100 
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Punto de 
Verificación 

Coordenadas UTM Zona 14 

 Porcentaje de  
afectación del Buffer 

  
  

Latitud Longitud 50m 100m 150m 

32 671,403.143324 1,949,019.682260 100 100 100 

33 655,439.865402 1,904,023.463060 100 100 100 

34 679,572.646564 1,908,559.914340 95 90 90 

35 677,795.993481 1,909,963.369170 90 60 40 

36 674,385.826919 1,933,129.376160 100 100 100 

37 675,384.544111 1,933,706.007440 75 60 60 

38 666,126.066853 1,970,632.239880 90 90 80 

39 670,232.790266 1,979,644.011430 85 50 40 

40 673,358.514478 1,936,502.561590 70 70 70 

41 652,832.177014 1,906,029.054890 70 40 40 

42 672,406.164269 1,922,512.153830 80 60 60 

43 666,342.157513 1,936,324.749210 75 40 30 

44 675,237.520007 1,932,314.121850 95 70 65 

45 674,373.932226 1,919,023.261020 90 70 60 

46 664,662.487467 1,971,083.306970 90 90 80 

47 675,831.853019 1,933,470.605570 90 65 70 

48 672,481.853374 1,916,453.757620 80 65 40 

49 672,528.419509 1,927,043.055280 100 65 60 

50 655,149.771007 1,910,090.808090 95 85 60 

51 674,659.411372 1,938,579.137120 92 70 45 

52 673,359.888946 1,916,851.527330 85 70 45 

53 675,123.545446 1,920,162.464860 100 70 65 

54 679,228.724026 1,917,345.685500 90 75 65 

55 675,289.410193 1,926,890.489120 70 70 70 

56 656,815.032943 1,904,504.432890 100 100 97 

57 672,726.852575 1,919,706.833670 30 30 30 

58 678,104.970149 1,910,075.673660 10 10 10 

59 673,917.913435 1,915,396.776660 90 90 90 

60 655,139.554684 1,901,888.667010 75 40 40 

61 674,868.447592 1,946,573.811650 75 70 65 

62 675,711.484079 1,932,370.093230 100 80 60 

63 672,697.650820 1,909,645.668400 20 20 20 

64 667,002.973688 1,982,709.203480 80 60 60 

65 650,301.614022 1,901,277.071570 95 95 90 

66 656,736.438925 1,892,848.450330 85 40 30 

67 655,941.773649 1,903,327.244440 100 75 60 

68 652,553.783119 1,977,665.362700 100 95 95 

69 656,038.301532 1,909,157.619350 100 55 40 
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Punto de 
Verificación 

Coordenadas UTM Zona 14 

 Porcentaje de  
afectación del Buffer 

  
  

Latitud Longitud 50m 100m 150m 

70 677,943.260363 1,916,326.740440 10 10 10 

71 663,269.913928 1,952,276.648780 90 80 60 

72 654,962.640827 1,902,421.613290 90 70 70 

73 675,975.269321 1,933,203.744660 80 60 50 

74 677,209.394517 1,902,526.150530 70 70 60 

75 658,303.409152 1,912,851.949390 0 0 10 

76 667,042.518366 1,981,435.304740 100 90 80 

77 653,586.802050 1,917,548.271600 5 5 5 

78 677,624.944364 1,902,507.802860 10 10 10 

79 655,556.072749 1,901,921.518280 80 65 55 

80 664,647.177318 1,933,340.337840 10 15 15 

81 674,596.472059 1,911,819.708310 100 90 75 

82 647,280.548426 1,932,882.842450 10 10 10 

83 673,231.804502 1,935,776.614200 70 55 50 

84 678,581.695979 1,909,805.186920 75 40 30 

85 679,729.845520 1,915,507.277700 10 10 10 

86 667,774.509786 1,943,420.835270 70 40 40 

87 672,897.792670 1,907,144.653270 75 55 40 

88 678,098.193849 1,911,765.939230 10 10 10 

89 673,874.311798 1,912,023.522780 80 40 20 

90 676,954.214262 1,902,235.465080 0 0 0 

91 652,452.335479 1,906,849.888170 85 55 50 

92 656,214.708995 1,908,266.282300 5 5 5 

93 678,569.709411 1,912,264.633150 10 10 10 

94 654,078.441283 1,902,146.271440 70 45 40 

95 672,793.034541 1,936,251.706660 80 75 70 

96 674,030.631998 1,914,720.604470 100 100 95 

97 653,400.163682 1,906,274.231440 100 80 60 

98 647,361.045835 1,916,562.973200 0 0 0 

99 680,615.503492 1,910,940.071360 70 60 50 

100 677,874.362753 1,922,233.738080 90 65 40 

101 657,626.159118 1,895,616.467530 75 60 40 

102 647,886.122888 1,932,082.115260 90 60 50 

103 672,324.580056 1,938,928.732670 100 90 70 

104 676,388.867339 1,920,933.825070 20 20 20 

105 678,906.513622 1,912,958.269990 65 50 40 

106 652,628.281884 1,905,758.379130 90 70 60 

107 676,452.689787 1,915,181.732900 80 40 30 
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Punto de 
Verificación 

Coordenadas UTM Zona 14 

 Porcentaje de  
afectación del Buffer 

  
  

Latitud Longitud 50m 100m 150m 

108 674,993.852255 1,930,820.185850 90 70 70 

109 669,778.429320 1,952,628.474410 85 70 60 

110 673,644.842619 1,936,327.767980 95 80 80 

111 678,993.013591 1,909,587.357820 70 70 70 

112 667,301.178101 1,943,439.837440 90 75 60 

113 674,333.965310 1,914,646.864350 95 95 90 

114 667,989.068930 1,968,673.356660 70 50 40 

115 674,382.359673 1,901,679.405580 95 80 80 

116 653,513.290200 1,900,950.497550 95 85 75 

117 648,208.665332 1,926,999.288340 0 0 0 

118 658,520.554993 1,906,527.728940 75 60 40 

119 677,509.485074 1,902,183.378740 10 10 10 

120 666,099.080467 1,968,030.446670 55 40 40 

121 664,254.222160 1,963,746.670960 75 60 60 

122 674,286.076157 1,939,128.001450 70 60 60 

123 672,701.092024 1,907,258.335330 55 40 40 

124 655,666.738956 1,904,702.458690 95 95 90 

125 679,086.008421 1,917,908.469080 40 35 30 

126 674,240.867630 1,912,900.315560 70 60 50 

127 673,097.621481 1,918,921.636760 95 75 50 

128 669,955.385497 1,970,035.540810 90 85 85 

129 670,586.756600 1,984,840.088170 0 0 0 

130 671,391.143693 1,986,667.938780 80 60 60 

131 649,212.165675 1,931,593.871760 0 0 0 

132 673,247.449417 1,909,528.333660 40 20 20 

133 680,215.844122 1,918,119.034620 90 70 60 

134 675,181.114128 1,914,686.141920 70 60 50 

135 657,026.754552 1,906,241.511930 80 80 70 

136 673,656.570484 1,916,972.515390 85 70 60 

137 676,939.809109 1,913,424.976100 90 40 40 

138 656,591.919225 1,908,608.044960 75 60 30 

139 672,346.055665 1,938,166.325160 60 70 60 

140 669,798.014180 1,979,775.734840 50 50 40 

141 666,368.926458 1,937,297.322230 5 5 5 

142 673,855.993673 1,920,475.765680 50 40 40 

143 677,519.723975 1,910,939.301720 50 30 30 

144 671,789.324491 1,948,275.413100 95 90 80 

145 672,231.129705 1,913,161.475590 75 60 40 
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Punto de 
Verificación 

Coordenadas UTM Zona 14 

 Porcentaje de  
afectación del Buffer 

  
  

Latitud Longitud 50m 100m 150m 

146 677,496.017773 1,929,214.925140 75 50 35 

147 677,012.131453 1,913,694.678000 75 50 40 

148 672,725.216933 1,939,435.811950 90 60 60 

149 651,610.151703 1,919,046.007690 100 95 75 

150 656,613.180242 1,893,708.433060 0 0 0 

151 674,582.502193 1,914,857.355500 70 55 40 

152 672,398.859958 1,914,032.366300 5 5 5 

153 669,033.783204 1,969,297.549880 95 60 60 

154 655,290.175711 1,909,238.843720 80 70 55 

155 677,617.053563 1,912,180.272400 75 40 40 

156 668,836.102922 1,981,450.920000 90 90 80 

157 670,827.965111 1,905,004.926370 10 5 5 

158 655,437.075404 1,904,351.582960 100 70 70 

159 673,143.612701 1,916,298.250810 30 30 30 

160 674,082.235378 1,911,664.702060 90 40 40 

161 676,718.815090 1,933,280.008550 10 30 40 

162 654,825.301863 1,907,641.148780 70 70 70 

163 677,915.070163 1,909,744.433010 80 60 40 

164 662,982.185166 1,965,529.590030 60 40 40 

165 676,205.022024 1,920,192.321890 30 40 50 

166 672,960.591160 1,923,246.089530 65 65 65 

167 654,312.049112 1,908,122.151880 100 100 100 

168 649,868.595930 1,927,926.800260 0 0 0 

169 680,533.377688 1,913,569.531300 70 60 40 

170 652,381.515055 1,976,981.637000 95 80 70 

171 655,869.931298 1,899,979.463660 100 100 100 

172 660,126.679111 1,961,777.795270 70 60 50 

173 665,207.759848 1,949,771.254130 30 30 40 

174 676,645.816274 1,912,504.402760 0 10 10 

175 655,999.207755 1,910,569.703440 100 85 75 

176 675,274.418756 1,915,716.960900 80 60 40 

177 670,760.991872 1,944,494.481570 80 75 50 

178 653,757.245378 1,923,327.253060 0 0 0 

179 674,954.308433 1,919,067.418210 85 70 55 

180 676,632.230506 1,924,846.186000 80 65 60 

181 675,872.743423 1,919,570.332040 90 85 70 

182 672,170.332622 1,938,929.915370 100 90 70 

183 650,510.745543 1,921,420.905970 100 90 70 
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Punto de 
Verificación 

Coordenadas UTM Zona 14 

 Porcentaje de  
afectación del Buffer 

  
  

Latitud Longitud 50m 100m 150m 

184 663,630.780159 1,957,796.543840 80 60 35 

185 653,321.022556 1,977,425.334430 100 90 70 

186 648,473.215647 1,935,555.004840 0 0 0 

187 674,280.638418 1,915,120.757540 75 40 40 

188 665,875.623823 1,946,755.853710 75 40 20 

189 669,551.358813 1,982,523.899930 60 20 30 

190 652,713.398555 1,977,015.155430 95 70 60 

191 673,773.085558 1,908,632.456730 30 30 30 

192 652,360.651077 1,907,304.497330 75 70 65 

193 654,883.790394 1,902,863.189940 10 10 10 

194 666,072.503317 1,947,768.411740 80 65 50 

195 668,299.649225 1,983,180.231940 50 40 30 

196 678,139.001575 1,915,476.594460 80 40 20 

197 645,153.028076 1,910,972.888000 0 0 0 

198 675,075.041481 1,909,230.664690 30 20 30 

199 680,597.432591 1,907,491.313630 80 50 50 

200 675,733.708602 1,927,171.740340 80 70 65 

201 654,910.275772 1,908,927.608320 100 100 100 

202 649,015.001012 1,973,555.186250 0 0 0 

203 662,974.067449 1,966,764.863400 95 85 70 

204 676,225.675162 1,913,168.699470 75 75 50 

205 674,884.679378 1,926,557.022980 80 60 40 

206 659,235.788113 1,906,255.387970 0 0 5 

207 656,254.400111 1,908,915.698540 85 65 40 

208 643,984.953949 1,934,553.027370 10 10 10 

209 674,015.759343 1,926,324.797700 80 80 80 

210 666,868.594003 1,947,331.512860 80 65 45 

211 656,198.079695 1,901,375.414360 80 70 60 

212 680,928.926154 1,906,297.504570 80 70 60 

213 668,615.722870 1,984,109.806430 90 70 60 

214 670,922.430604 1,983,531.835380 80 65 40 

215 656,665.838153 1,904,164.968600 100 100 80 

216 675,583.296964 1,915,259.392150 70 65 60 

217 679,558.503676 1,917,388.766530 70 60 60 

218 656,699.150449 1,905,812.788540 100 80 65 

219 655,688.500538 1,903,593.586330 100 90 65 

220 678,492.436796 1,912,578.461800 70 40 30 

221 669,836.235873 1,984,744.202470 20 20 20 
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Coordenadas UTM Zona 14 

 Porcentaje de  
afectación del Buffer 

  
  

Latitud Longitud 50m 100m 150m 

222 656,056.822582 1,909,576.821160 100 95 85 

223 667,592.326445 1,943,921.402880 90 65 65 

224 656,047.876100 1,902,823.469920 85 85 80 

225 675,720.000427 1,914,171.364930 100 100 85 

226 672,561.594588 1,935,845.776550 96 60 50 

227 650,797.652377 1,921,225.930120 100 95 88 

228 675,508.115886 1,913,727.279020 100 95 60 

229 675,032.759155 1,915,512.204980 80 60 60 

230 662,969.694667 1,963,676.111050 100 95 65 

231 656,507.541804 1,903,900.539530 100 90 70 

232 656,511.617454 1,909,916.933330 75 65 60 

233 677,534.686955 1,918,897.074530 90 70 65 

234 650,887.483720 1,932,743.340780 10 30 40 

235 652,398.156730 1,905,972.150830 90 80 60 

236 678,368.516976 1,922,757.132950 70 60 60 

237 654,841.576492 1,901,561.031070 100 100 90 

238 676,578.543728 1,926,134.248020 80 70 70 

239 671,384.758575 1,981,841.408420 100 90 80 

240 675,719.564985 1,920,090.100000 70 80 80 

241 661,657.611325 1,963,142.345900 70 60 40 

242 665,020.118340 1,943,506.972100 70 60 60 

243 670,980.511125 1,944,131.585150 65 65 65 

244 674,416.240783 1,926,435.902180 70 70 60 

245 667,022.285106 1,968,767.864930 30 35 40 

246 672,917.541435 1,936,786.265790 90 90 70 

247 664,961.300670 1,973,816.351430 65 45 30 

248 677,690.059262 1,926,620.759860 75 60 50 

249 670,551.303856 1,981,718.568410 80 60 40 

250 646,166.694830 1,932,193.658580 70 65 50 

251 656,333.483347 1,909,364.318150 75 70 70 

252 666,393.024379 1,936,043.484900 55 30 15 

253 670,070.474660 1,951,760.331680 65 40 40 

254 678,249.285945 1,909,519.202320 85 40 30 

255 673,264.863070 1,936,097.606140 90 70 55 

256 652,744.934270 1,895,052.625870 0 0 5 

257 671,488.838834 1,938,785.247510 75 40 20 

258 652,467.875577 1,905,494.645440 70 60 50 

259 674,321.630067 1,911,645.923040 95 80 70 
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260 671,256.763566 1,910,758.716430 80 50 35 

261 668,526.613507 1,980,300.895460 80 80 65 

262 655,115.986612 1,904,674.067010 85 60 40 

263 674,580.601203 1,915,208.402580 100 85 60 

264 651,353.848378 1,930,672.551920 95 95 80 

265 669,206.879917 1,952,908.781470 80 40 30 

266 654,869.308388 1,909,451.946320 100 80 80 

267 656,770.892945 1,904,911.418370 95 80 70 

268 659,106.249441 1,905,326.191030 70 65 60 

269 656,486.566363 1,904,635.099510 85 75 70 

270 659,202.519939 1,890,943.637170 55 30 15 

271 657,734.775926 1,897,510.478190 75 50 40 

272 669,005.622202 1,953,854.243860 80 70 50 

273 670,231.968405 1,954,084.431820 50 40 35 

274 669,386.622964 1,952,580.272560 70 60 55 

275 668,169.569674 1,970,441.816350 70 60 60 

276 672,091.872975 1,939,887.296350 70 60 50 

277 677,807.525283 1,937,685.074730 100 95 95 

278 670,825.177570 1,947,895.470300 100 90 85 

279 650,855.773023 1,920,188.422270 100 90 90 

280 650,213.053817 1,920,883.199050 95 95 95 

281 654,279.829776 1,904,939.826330 100 95 95 

282 676,948.513467 1,925,234.539440 80 80 75 

283 652,298.712875 1,909,106.197110 95 85 85 

284 654,033.180000 1,909,149.541900 90 75 70 

285 675,522.377496 1,912,879.872130 100 95 90 

286 682,100.208311 1,913,950.789660 10 10 10 

287 678,963.345273 1,917,092.966200 100 75 70 

288 650,072.915406 1,921,480.798750 100 95 88 

289 671,683.590170 1,945,565.721930 90 70 65 

 


	PORTADA
	CARTA DE CONSENTIMIENTO
	HOJA DE FIRMAS
	RESUMEN
	ABSTRACT
	AGRADECIMIENTOS
	DEDICATORIA
	CONTENIDO
	LISTA DE CUADROS
	LISTA DE FIGURAS
	1. INTRODUCCIÓN
	2. OBJETIVOS
	2.1. General
	2.2. Objetivos particulares

	3. HIPOTESIS
	4. REVISION DE LITERATURA
	4.1. Variables que influyen en la formación de cárcavas
	4.1.1. Variable antrópicas
	4.1.2. Variables físicas

	4.2 Procesos de aparición de cárcavas
	4.3 Uso de los sensores remostos y SIG
	4.4 Enfoques para el estudio de las cárcavas
	4.5. Técnicas de análisis para la identificación de cárcavas
	4.5.1. Análisis multicriterio
	4.5.2. Análisis multivariado
	4.5.3. Clasificación supervisada


	5. MATERIALES Y MÉTODOS
	5.1. Caracterización biofísica
	5.1.1. Ubicación geográfica del área de estudio
	5.1.2. Clima
	5.1.2.2. Grupo climático semicálido del grupo de los cálidos
	5.1.2.3. Grupo climático seco
	5.1.2.4. Grupo climático Templados
	5.1.2.5. Grupo climático Templado Semifrío
	5.1.3. Suelos

	5.1.3. Suelos
	5.1.3.1. Descripción de los tipos de suelos

	5.1.4. Fisiografía
	5.1.4.1. Provincia Fisiográfica Sierra Madre del Sur
	5.1.4.2. Subprovincia Cordillera Costera del Sur
	5.1.4.3. Subprovincia Mixteca Alta
	5.1.4.4. Subprovincia Sierras Centrales de Oaxaca

	5.1.5. Hidrología
	5.1.5.1. Regiones y cuencas hidrológicas

	5.1.6. Geología
	5.1.6.1. Tipos de rocas
	5.1.6.2. Estratigrafía regional
	5.1.6.3. Falla Tamazulapam.

	5.1.7. Uso de suelo y vegetación

	5.2. Materiales
	5.3. Métodos
	5.3.1. Recopilación y análisis
	5.3.2. Recopilación de información de relieve
	5.3.3. recopilación de información satelital
	5.3.4. Recopilación de información de campo
	5.3.5. Obtención de variables
	5.3.5.1. Variables topográficas
	5.3.5.2. Variables hidrológicas
	5.3.5.3 Variables geológicas
	5.3.5.4. Variables Cobertura vegetal
	5.3.5.5. Variable antropogénica

	5.3.6. Escalamiento de variables
	5.3.7. Analisis de componentes principales
	5.3.8. Clasificación supervisada para determinar la susceptibilidad a la formación de cárcavas
	5.3.8.1. Áreas de entrenamiento
	5.3.8.2. Creación de firmas ambientales
	5.3.8.3. Clasificación supervisada
	5.3.8.4. Puntos de inspección
	5.3.8.5. Confiabilidad de la clasificación



	6. RESULTADOS
	6.1. Variables seleccionadas
	6.1.1. Pendiente topográfica
	6.1.2. Curvatura vertical o de perfil (CV)
	6.1.3. Curvatura Horizontal o plana (CH)
	6.1.4. Longitud de la pendiente
	6.1.5. Índice de posición topográfica
	6.1.6. Índice topográfico de humedad
	6.1.7. Distancia a picos
	6.1.8. Distancia a fallas
	6.1.9. Índice de Vegetación de Diferencia Normalizada
	6.1.10. Densidad de Población

	6.2. Análisis de componentes principales
	6.2.1. Descripción de los Componentes principales seleccionados
	6.2.2. Cobertura raster resultado del ACP

	6.3. Probabilidad de existencia de cárcavas
	6.4. Validación de resultados

	7. CONCLUSIONES
	8. RECOMENDACIONES
	9. LITERARURA CITADA
	10. ANEXOS
	Anexo 1. Puntos de verificación en google earth.




